Select the Capture Cursor check box to include the application's cursor in the captured image. When checked and the Use
Timer check box on the General/Timer page, Capture Professional displays the proper cursor for the window under the cursor
while capturing images. Otherwise, Capture Professional will display the corresponding capture mode cursor while capturing
images.

This option applies to the following capture modes: Active Client Area, Active Window, Client Area, Desktop and Window.



Select the Bring Window To Top Before Capturing check box to place the selected window on top of other windows before
capture. This will place any obstructing windows behind the captured window.

If the captured window is being disrupted during capture, clearing this check box may help.

This option applies to following capture modes: Active Client Area, Active Window, Client Area and Window.



Select the Show Image Size During Capture check box to display the selection area size within the selection area during image
capture.

This option applies to the following capture modes: Oval and Rectangle.



Select the Fixed Size Capture check box to capture an image of fixed size. Set the fixed size in the X and Y edit boxes.

This option applies to the following capture modes: Oval and Rectangle.



Enter the fixed width of the selection area in the X edit box. To use this value, select the Fixed Size check box.

This option applies to the following capture modes: Oval and Rectangle.



Enter the fixed height of the selection area in the Y edit box. To use this value, select the Fixed Size check box.

This option applies to the following capture modes: Oval and Rectangle.



Select the color to fill the area of the rectangular image not covered by the non-rectangular captured image from the Background
Fill Color combo box.

This option applies to the following capture modes: Oval and Polygon.



Select the Enable Capture Hotkeys check box to enable hotkeys for capturing an image.



Select the hotkey to capture the entire screen from the Desktop Capture Hotkey combo box.



Select the hotkey to begin capturing an icon from the Icon Capture Hotkey combo box.



Select the hotkey to begin capturing an oval from the Oval Capture Hotkey combo box.



Select the hotkey to begin capturing a rectangle from the Rectangle Capture Hotkey combo box.



Select the hotkey to begin capturing a polygon from the Polygon Capture Hotkey combo box.



Select the hotkey to begin capturing a client area from the Client Area Capture Hotkey combo box.



Select the hotkey to begin capturing a window from the Window Capture Hotkey combo box.



Select the hotkey to force Capture Professional to appear from the Show Window combo box. This hotkey is useful when using
the Hide on Minimize option (found on the General/Timer tab).



Select the Print Screen Sends Image To Printer check box to cause Capture Professional to send the entire screen or active
window to the printer after the Print Screen key is pressed. Capture Professional displays the Print dialog after pressing the
Print Screen key, allowing the print job to be configured.

Note: Capture Professional must be running for this option to be used.



Select the Hide on Minimize check box to hide Capture Professional when minimized.  Use the Show Window hotkey (found on
the Hotkey Setup page) to restore Capture Professional when hidden.



Select the Popup After Capture check box to cause Capture Professional to reappear in its previous position after capturing an
image. When cleared, Capture Professional will appear minimized after capturing an image.



Select the Always On Top check box to cause Capture Professional to stay on top of other windows.



Select the Last Position radio button to start Capture Professional in its last position.



Select the Always Minimized radio button to minimize Capture Professional on startup.



Select the Use Timer check box to cause Capture Professional to pause a specified number of seconds before capturing an
image. This pause occurs after selecting the area to capture which provides an opportunity to set up the screen.

Set the length of this pause in the Duration edit box.



Enter the number of seconds between the selection and the capture of the first image in the Time before first capture edit box. A
value between one second and 3,600 seconds (1 hour) can be used.

Select the Use Timer check box to enter a value in this edit box.



Select the Inches radio button to use inches as Capture Professional's unit of measurement in the Print dialog.



Select the centimeters radio button to use centimeters as Capture Professional's unit of measurement in the Print dialog.



Select the Enable Direct Capture check box to send a captured image directly to the destination selected in the Capture Direct
To group box.



Select the File radio button to automatically save an image after capture. Select the Enable Direct Capture check box to enable
this option. Capture Professional will create an image window if the Create Image Window After Direct Capture check box is

selected or if the file save operation fails.

When using the AutoName feature, Capture Professional will automatically name and save the file without using the Save dialog.



Select the Clipboard radio button to automatically copy an image to the clipboard after capture. Select the Enable Direct
Capture check box to enable this option. Capture Professional will create an image window if the Create Image Window After
Direct Capture check box is selected or if the copy operation fails.



Select the Print radio button to print an image after it is captured. Select the Enable Direct Capture check box to enable this
option. Capture Professional will create an image window if the Create Image Window After Direct Capture check box is selected
or if the print operation fails.



Select the Application radio button to automatically send an image to a Windows application after capture. Select the Enable
Direct Capture check box to enable this option. Capture Professional will create an image window if the Create Image Window
After Direct Capture check box is selected or if the operation fails.

Click the Find Application button or select the Edit/Find Application menu item to choose the direct capture Windows application.



Select the Create Image Window After Direct check box to create an image window after direct capture. When cleared,
Capture Professional sends the captured image to the selected destination without creating an image window. This option has
no effect if the Enable Direct Capture check box is not checked.



Select the 2 Color radio button to save the current image in black and white. This radio button is disabled when the chosen file
format cannot be saved using 2 colors.



Select the 16 Color radio button to save the current image using 16 colors. This radio button is disabled when the chosen file
format cannot be saved using 16 colors.



Select the 256 Color radio button to save the current image using 256 colors. This radio button is disabled when the chosen file
format cannot be saved using 256 colors.



Select the 16.7M Color radio button to save the current image using 24-bit true color. This radio button is disabled when the
chosen file format cannot be saved using 16.7M colors.



Select the Scatter radio button to reduce the current image to black and white using the scatter technique. This radio button is
enabled when the 2 Color radio button is selected and the current image is not already black and white.

The scatter technigue works best for photos and digitized images.  For more information see the Threshold vs Dither vs Scatter
topic.



Select the Dither radio button to reduce the current image to black and white using the dither technique. This radio button is
enabled when the 2 Color radio button is selected and the current image is not already black and white.

The dither technique works best non-photo color images containing many colors. For more information see the Threshold vs
Dither vs Scatter topic.



Select the Threshold radio button to reduce the current image to black and white using the threshold technique. This radio
button is enabled when the 2 Color radio button is selected and the current image is not already black and white.

The threshold technique works best non-photo color images containing a few colors. For more information see the Threshold vs
Dither vs Scatter topic.

To specify a custom threshold:

Step 1. Exit the Save dialog.

Step 2. Select the Operations/Convert To/Black & White menu item.
Step 3. Select the Threshold radio button.

Step 4. Use the slider to select the proper threshold.

Step 5. Click the OK button.

Step 6. Select the File/Save As menu item.

Step 7. Select the 2 Color radio button.

Step 8. Click the Save button.



Select the type of compression to use from the Compression combo box. The compression types listed in the Compression
combo box are dependent on the file type chosen in the Save as type combo box.

HINT: Not all programs recognize all compression methods. Verify that the selected compression method is compatible with
programs that will use the images before capturing many images. In some cases, 'None' may be the best choice.



Select the AutoName checkbox to automatically name all new images based on the file name specified in the Save dialog.

When checked, Capture Professional inserts "0000" before file extension. All subsequent images saved using the Eile/Save

menu item are named using the chosen file name and an incrementing, four digit number on the end.

Example:
The AutoName check box is selected and c:\reports\report.omp is specified in the File name edit box.

Capture Professional will save the current image as c:\reports\report0000.bmp.
The next image saved using the File /Save menu item , will be automatically saved as c:\reports\report0001.bmp.
The next image saved using the Eile /Save menu item , will be automatically saved as c:\reports\report0002.bmp.

See Also:

AutoNaming Files
How To Automatically Name Files



Enter the image's horizontal file resolution in the X edit box. The value in the Units combo box determines whether the
horizontal resolution is measured in centimeters or inches. Other applications may use setting to determine how to format the
image. This has no effect within Capture Professional. This edit box is visible for Bitmap, PCX and TIFF file types.



Select the unit of measurement for the horizontal and vertical file resolution from the Units combo box. This combo box is
visible for Bitmap, PCX and TIFF file types.



This preview window displays an approximation of what the image will ook like on the printer.



Enter the width of the left margin in the Left edit box. The printed image will not extend beyond this margin, unless the Fit To
Max Page radio button is selected. The lower-left group box displays the range of legal values when this edit box has focus.
This edit box is disabled when the Fit To Max Page radio button is selected.

Select the Center Horizontally check box to center the image between the left and right margins.



Enter the height of the top margin in the Top edit box. The printed image will not extend beyond this margin, unless the Fit To
Max Page radio button is selected. The lower-left group box displays the range of legal values when this edit box has focus.
This edit box is disabled when the Fit To Max Page radio button is selected.

Select the Center Vertically check box to center the image between the top and bottom margins.



Enter the width of the right margin in the Right edit box. The printed image will not extend beyond this margin, unless the Fit To
Max Page radio button is selected. The lower-left group box displays the range of legal values when this edit box has focus.
This edit box is disabled when the Fit To Max Page radio button is selected.

Select the Center Horizontally check box to center the image between the left and right margins.



Enter the height of the bottom margin in the Bottom edit box. The printed image will not extend beyond this margin, unless the
Fit To Max Page radio button is selected. The lower-left group box displays the range of legal values when this edit box has
focus. This edit box is disabled when the Fit To Max Page radio button is selected.

Select the Center Vertically check box to center the image between the top and bottom margins.



Select the Center Horizontally check box to center the image between the left and right margins.



Select the Center Vertically check box to center the image between the top and bottom margins.



Select the Manual radio button to specify the image size using the Width, Height or Scale edit boxes. Selecting the Manual
radio button will enable the Width, Height and Scale edit boxes.



Select the Fit To Page radio button to size the printed image to the maximum that will fit within the specified margins while
maintaining an identical horizontal and vertical scale.



Enter the width of the printed image in the Width edit box. Changing this value will adjust the values in the Height and Scale
edit boxes. The lower-left group box displays the range of legal values when this edit box has focus. Select the Manual radio
button to enable this edit box.



Enter the height of the printed image in the Height edit box. Changing this value will adjust the values in the Width and Scale
edit boxes. The lower-left group box displays the range of legal values when this edit box has focus. Select the Manual radio
button to enable this edit box.



Enter the scale of the printed image in the Scale edit box. Changing this value will adjust the values in the Width and Height
edit boxes. The lower-left group box displays the range of legal values when this edit box has focus. Select the Manual radio
button to enable this edit box.

Scale is the ratio of the image's pixels to printed pixels. Using the same scale maintains consistency between multiple printed
images.



Select the Normal radio button to print the current image without enhancement. This method allows the printer to determine
how to print a given color yielding color results on a color printer and dithered results on a black & white printer.



Select the B & W Halftone radio button to dither the current image to black & white before printing. This method is best for non-
photographic images on a black and white printer. The Halftone method is slower than the Normal method.

For more information see Threshold vs. Dither vs. Scatter



Select the B & W Scatter radio button to scatter the current image to black & white before printing. This method is best for
photographic images on a black and white printer. The Scatter method is slower than the Normal method.

For more information see Threshold vs. Dither vs. Scatter



Select the Threshold radio button to convert to the current image black and white using the threshold value below. When
printed, all pixels brighter than the threshold value are converted to white, all others are converted to black. Increasing the
threshold makes the image darker.

For more information see Threshold vs. Dither vs. Scatter



Enter the threshold value in the Threshold edit box. When printed, all pixels brighter than the threshold value are converted to
white, all others are converted to black. Increasing the threshold makes the image darker.

For more information see Threshold vs. Dither vs. Scatter



Move the Threshold slider to the right to make the image darker. Move the Threshold slider to the left to make the image
brighter.

For more information see Threshold vs. Dither vs. Scatter



Select the Dither radio button to convert the current image to black and white using a dithering algorithm.  This method is best
for non-photographic color images with large areas of similar color.

For more information see Threshold vs. Dither vs. Scatter



Select the Scatter radio button to convert the current image to black and white using a scatter algorithm. This method is best for
photographic color images

For more information see Threshold vs. Dither vs. Scatter



Enter the user name in the User edit box exactly as provided. The serial number is dependent on the provided user name.
Entering a user name other than the provided user name will cause the serial number to fail.



Enter the company name in the Company edit box exactly as provided. The serial number is dependent on the provided
company name. Entering a company name other than the provided company name will cause the serial number to fail.

If this copy of Capture Professional is for private use, "Personal Copy" will be specified as the company name.



Enter the serial number in the leftmost Serial Number edit box. The focus will move to the next edit box when the current edit
box contains the correct number of characters. Do not type the hyphen that appears in the serial number.



Press the Order Form button to display the order form in the help file. The order form can then be printed.



Capture Professional Order FOorm  (select the File/Print menu item to Print.)
Mail to: Creative Softworx OR Fax:
1070 Chasewood Trail (800)430-WORX (US Only)
Alpharetta, GA 30005 or (770)569-1683

First Name:

Last Name:
Company: __ _

Space)
Address:

Country

Georgia Residents Indicate County:

Phone Number (If we have questions concerning your order):

Please Send Serial Number Immediately Via:

__Fax: __Email:

# Licenses Description Cost/License Total
Capture Professional 3 $39.95
Capture Professional 3 Five User $100.00

SHIPPING CHART Total Order $

us $5.00 Shipping: (See Chart To Left) $

Foreign $7.00 Sales Tax: Georgia Residents Add 7% $

Next Day Fed Ex $12.50 (US ONLY) Final Total $

Send my serial number information to the e-mail or fax number above ONLY. |
understand that nothing will be shipped to me and that I will not be billed for any shipping
charges.

Method of Payment (Check One):
____CheckiMoney Order [Payable to Creative Softworx, drawn from US banks only]
____ Credit Card: Master Card VISA AMEX DISCOVER

Expires: |/

Account #:

Bank of Issue: Signature:




Optional Comments:
I rate Capture Professional a: low 1 2 3 45 6 7 8 9 10 High

Comments:

Creative Softworx reserves the right to correct any orders.



Registration dialog

The registration dialog appears only in the demo version of Capture Professional.

1. It distinguishes the demo version from the purchased version.
2. It changes the demo version into the full featured version by entering serial number information that is delivered via fax or via
e-mail (normally within 24 hours) after purchase. This eliminates the wait for Capture Professional to arrive or the need

to pay for expensive overnight shipping.

It serves two purposes:



Ordering

There are many ways to order Capture Professional. Site licensing is available at a significant discount. Creative Softworx
accepts the following credit cards: VISA, MC, American Express and Discover. Only checks or money orders in U.S. funds AND
drawn on a U.S. bank will be accepted.
1. Call 1-800-680-9679 (US only) or call 770-569-7545 (other countries) and place a voice order. Operators are standing by in
the US 24 hours a day, 7 days a week. Only credit card orders are accepted at this phone number.
2. Print out the Order Form, fill it out and fax it with a credit card number to 1-800-430-9679 (US Only) or 770-569-1683 (other
countries). Do not fax a check.
3. Print out the Order Form, fill it out and mail it. Include a check, money order or credit card number. The address is:
Creative Softworx
1070 Chasewood Trail
Alpharetta, GA 30005
United States

4. Order using CompuServe’s SWREG forum. The registration ID for a single user license is 3154. The registration ID for a
five-user license is 9431.

Please allow up to three weeks for delivery of a package.



Technical Support

Technical support can be reached in the following four ways.
Please review the Capture Professional help file and other documentation before contacting technical support.

E-Mail:

Fax:
Phone:

Web Page:

This is the best avenue for technical support. The average response time during business hours is 4 hours.
Send a detailed description of the problem and the steps required to reproduce it to
support@creativesoftworx.com.

Fax a detailed description of the problem and the steps required to reproduce it to 770-569-1683.

Call 770-569-1635. Select technical support from the voice menu. Messages will be returned within one
business day.

Download the latest version of Capture Professional from our web site: http://www.creativesoftworx.com. lItis
Creative Softworx's policy that all versions with the same first digit are free upgrades (3.1, 3.5, 3.X...).

To upgrade, download the most recent demo from our web site. Then install the demo software in the
existing Capture Professional directory.



Direct Capture Page

The Direct Capture page sets the direct capture options within Capture Professional.

Capture Professional can automatically send an image to a selected destination (a file, the clipboard, a printer or a Windows
95/NT 4.0 application that supports graphics). When the Enable Direct Capture check box is selected an image window will be
created if the direct capture fails or if the Create Windows After Direct Capture check box is selected.

For more details on these options:

Step 1. Select the Eile/Preferences menu item to display the Preferences dialog.
Step 2. Select the Direct Capture tab on the Preferences dialog.
Step 3. Click the “?” in the upper right corner of the Preferences dialog.

Step 4. Click on the desired control.



GenerallTimer Page

The General/Timer page sets general and timer options within Capture Professional.

. The timer inserts a delay between the selection of what to capture and the actual capture of that image. This provides the
specified time to set up the selected area. Multiple images can be captured using the timer. For more information, see
Using the Timer.

e The unit of measurement setting is used within the Print dialog for displaying the margins and dimensions.

For more details on these options:

Step 1. Select the File/Preferences menu item to display the Preferences dialog.
Step 2. Select the General/Timer tab on the Preferences dialog.
Step 3. Click the “?” in the upper right corner of the Preferences dialog.

Step 4. Click on the desired control.



Hotkey Setup Page

The Hotkey Setup page sets hotkey options within Capture Professional.

. Capture Professional uses hotkeys to capture images. A hotkey is a key combination that can be accessed from any
application. This page changes or disables the hotkeys Capture Professional uses. Changing a hotkey may be
necessary if the hotkey conflicts with other applications. Selecting “None” from a combo box disables the associated
hotkey.

. Sets whether Capture Professional enhances the functionality of the print screen key. Normally when the print screen key
is pressed, Windows captures the whole screen and puts it in the clipboard. Capture Professional can enhance this by
displaying the Print dialog, to quickly print the screen. This is similar to the behavior of the print screen key in DOS.

For more details on these options:

Step 1. Select the File/Preferences menu item to display the Preferences dialog.
Step 2. Select the Hotkey Setup tab on the Preferences dialog.

Step 3. Click the “?” in the upper right corner of the Preferences dialog.

Step 4. Click on the desired control.

To change a hotkey:

Step 1. Choose which capture mode’s hotkey to change.

Step 2. If the desired hotkey sequence contains the control key, select the associated Control check box. If not, clear
the associated Control check box.

Step 3. If the desired hotkey sequence contains the alt key, select the associated Alt check box. If not, clear the
associated Alt check box.

Step 4. If the desired hotkey sequence contains the shift key, select the associated Shift check box. If not, clear the
associated Shift check box.

Step 5. Select the hotkey to use from the associated combo box. The hotkey combination cannot conflict with

another hotkey conbination.



Capture Options Page

The Capture Options page sets options specific to certain mode within Capture Professional. The options displayed in the
Screen Capture Options group box apply to one or more capture modes. For example, the Brind Window to Top option is used
in client area and window modes, but is not used in rectangle mode.

For more details on these options:

Step 1. Select the FEile/Preferences menu item to display the Preferences dialog.
Step 2. Select the Capture Options tab on the Preferences dialog.
Step 3. Click the “?” in the upper right corner of the Preferences dialog.

Step 4. Click on the desired control.



Print Dialog

Capture Professional’s Print dialog is similar to the common print dialog within Windows 95/NT 4.0. The Print dialog has
additional controls to specify the position, size and dithering of the printed image on the page. The Preview window displays
approximately what the image will look like on that printed page.

Positioning is determined by margins, the Center Horizontal check box and the Center Vertical check box. Margins are preserved
between print jobs and can be set in one of two ways:

Method 1: Select the Manual or Fit To Page radio buttons. Then enter the desired margins in the Left, Top, Right and
Bottom edit boxes.
Method 2: Select the Fit To Max Page radio button to use the minimum allowed printer margins.

Size can be set in one of five ways:

Method 1: Select the Manual radio button and enter the desired width in the Width edit box. The height and scale
values will change to reflect the new scale.

Method 2: Select the Manual radio button and enter the desired height in the Height edit box. The width and scale
values will change to reflect the new scale.

Method 3: Select the Manual radio button and enter the desired scale in the Scale edit box. The width and height
values will change to reflect the new scale.

Method 4: Select the Fit To Page radio button. This option will print the current image in the maximum size that will fit
on within the specified margins.

Method 5: Select the Fit To Max Page radio button.

Regardless how an image is sized, Capture Professional will maintain the image's width to height ratio and will attempt to
preserve the printed scale between print jobs.

Selecting the Normal, B & W Halftone or B & W Scatter radio buttons sets dithering.

All values within the Print dialog (except scale) are measured in inches or centimeters. This option is set in the General/Timer
Options Page of the Preferences dialog.

For more details on these options:

Step 1. Select the File/Print menu item to display the Print dialog.
Step 3. Click the “?” in the upper right corner of the Print dialog
Step 4. Click on the desired control.




Save Dialog
Capture Professional’s Save dialog is similar to other save dialogs within Windows 95/NT 4.0. The Save dialog has additional

controls to specify file type, color depth, compression, autonaming and file resolution. File type and color depth should be
chosen first because other options are dependent upon these settings.

Capture Professional supports the following file types and color depths:

COLORS
FILE TYPE 2 16 256 16.7M
BMP Yes Yes Yes Yes
EPS No No Yes No
ICO No Yes No No
GIF** Yes Yes Yes No
JPG No No Yes* Yes*
PCX Yes No Yes No
PNG** Yes No Yes Yes
RLE No Yes* Yes* No
TGA No No No Yes*
TIF Yes* No Yes* Yes

* Compression options are available for these file type and color depth combinations.
** These formats always use image compression.

When saving a 2 color image and the current image is not a black and white image, select the Scatter, Dither and Threshold
radio buttons to determine how the current image is reduced to black and white.

File resolution can be set for BMP, PCX and TIF images using the X edit boxes, Y edit box and Units combo box.  This setting
may affect how other applications display the current file.

The JPEG format is a lossy format. This means that the saved image will not exactly resemble the viewed image. The amount
of loss is controlled by selecting the desired image quality or [Preview Before Saving] in the Compression combo box. If the
[Preview Before Saving] item is selected, the JPEG Preview dialog will appear after pressing the Save button.

Select the AutoName check box to start the AutoNaming process.

For more details on these options:

Step 1. Select the File/Save As menu item to display the Save dialog.
Step 2. Click the “?” in the upper right corner of the Save dialog.
Step 3. Click on the desired control.




Choose the application to capture direct to from this list box.



Choose Application Dialog

The Choose Application dialog selects the application that Capture Professional captures directly to or copies images to. It
contains a list of running applications that Capture Professional has identified that will handle graphical data. It is not
guaranteed that all applications in this list will work well with Capture Professional.

Select the Edit/Find Application menu item to display this dialog.




Convert To Black and White Dialog

The Convert To Black and White dialog selects the method used to convert a color or grayscale image to black and white.

For more details on these options:

Step 1. Select the Operations/Convert To/Black & White menu item to display the Convert To Black and White dialog.
Step 2. Click the “?” in the upper right corner of the Save dialog.

Step 3. Click on the desired control.



Capturing Basics

Capture Professional works in three basic stages: Acquisition, Editing and Output.

Acquisition Stage:

An image can be acquired by capturing an image, opening an image, extracting a resource or capturing an image from the
clipboard

Acquisition by Capturing an Image:

Step 1. Depending on the capture mode an area of the screen is manually or automatically selected.
Step 2. An image is created from the captured area.
Step 3. If the direct capture feature is not being used, an image window is created within Capture Professional to

display and edit the captured image.

Acquisition by Opening an Image:

Step 1. The Open File dialog is used to select a file.
Step 2. An image is created from the specified file
Step 3. An image window is created within Capture Professional to display and edit the opened image.

Acquisition by Extracting a Resource:

Step 1. The Extract dialog is used to select a 32-Bit executable and a resource within the selected executable.
Step 2. An image is copied for the specified image resource.
Step 3. An image window is created within Capture Professional to display and edit the extracted image.

Acquisition by Capturing an Image from the Clipboard:
Step 1. An image is copied from a bitmap or DIB in the clipboard.
Step 2. An image window is created within Capture Professional to display and edit the captured image.

Editing Stage:
An image can be edited by using a drawing tool, performing an operation or using an effect. A near infinite number of edits can
be undone and redone singly or multiply with the Undo/Redo Actions dialog.

Output Stage:

An image can be saved to a file using the Save Dialog, printed using the Print dialog, copied to the clipboard or copied to another
Windows application.



Capture Modes

Capture Professional features several ways to captures images:

Active Client Area:

Use active client area mode to capture the active window, MINUS the menu, caption bar and other non-client areas that will vary
from application to application. When using active client area mode, Capture Professional can automatically scroll a client area
with an enabled scroll bar to capture the entire image. For step by step instructions, see How to Capture the Active Client Area.

Active Window:

Use active window mode to capture the active window, INCLUDING the menu, caption bar and other non-client areas that will
vary from application to application. For step by step instructions, see How to Capture the Active Window.

Client Area:

Use Client Area mode to capture a window on the screen, MINUS the menu, caption bar and other non-client areas that will vary
from application to application. When using client area mode, Capture Professional can automatically scroll a client area with
an enabled scroll bar to capture the entire image. For step by step instructions, see How to Capture a Client Area.

Control:
Use control mode to capture controls such as edit boxes, list boxes and combo boxes. For step by step instructions, see How
to Capture a Control.

Desktop:
Use desktop mode to capture the entire screen. For step by step instructions, see How to Capture the Entire Screen.

Icon:

Use icon mode to capture a 32 X 32-pixel area. This is ideal for capturing icons. Other modes can be used to capture icons.
However, if an image is not 32 pixels by 32 pixels detail may be lost. For step by step instructions, see How to Capture an Icon.

Menu:

Use menu mode to capture a popup menu or single menu from an application's menu bar. This mode will include every parent
menu to the chosen menu. To capture multiple menus from an application's menu bar, the Menu Capture Wizard should be
used. For step by step instructions, see How to Capture a Menu.

Oval:

Use oval mode to capture an oval area of the screen. Since graphics formats are rectangular in nature, Capture Professional
captures the image as the smallest rectangle that can encompass the oval. Capture Professional fills the area of the rectangle
not covered by the oval with the color chosen in the corresponding Background Combo Box of the Preferences dialog. For step

by step instructions, see How to Capture a Circle or an Ellipse.

Polygon:

Use polygon mode to capture a polygonal area of the screen. Since graphics formats are rectangular in nature, Capture
Professional saves the image as the smallest rectangle that can encompass the polygon. Capture Professional fills the area of
the rectangle not covered by the polygon with the color chosen in the corresponding Background Combo Box of the Preferences

dialog. . For step by step instructions, see How to Capture a Polygon.

Rectangle:
Use rectangle mode to capture a rectangular portion of the screen. For step by step instructions, see How to Capture a
Rectangle.

Window:

Use window mode to capture a window on the screen, INCLUDING the menu, caption bar and other non-client areas that will
vary from application to application. Window mode is also useful for capturing menus. For step by step instructions, see How to
Capture a Window.

Repeat Last Capture:

Capture Professional can repeat the last capture performed, speeding multiple captures. For step by step instructions, see How
to Repeat Captures.

If the last capture mode used was Active Window, Active Client Area, Client Area, Control or Window, Capture Professional will
attempt to find the same window. If the window does not exist (or has been destroyed and recreated) the repeat last capture will



fail.

If the last capture mode used was Desktop, Icon, Oval Polygon or Rectangle, the last area captured will be captured again
without user input.



Direct Capture

Capture Professional can automatically send a captured image directly to a file, the printer, the clipboard and even other
applications. These options are set on the Direct Capture page of the Preferences dialog.

If one of the direct options is used, an image window will not be created unless the Create Window check box in the Preferences
dialog is checked.

Capture Direct To Application:

Capturing directly to an application is one of Capture Professional’s unique features. This feature will work with most
applications that can handle graphics. There may be some applications that are incompatible with this process.

The following is an example of how this feature works. ~ With Capture Professional, a word processor, and the target application
running, press one of the capture hotkeys. The word processor and Capture Professional will disappear from the screen. The
image is captured with a few mouse clicks. The captured image will automatically appear at the previous cursor location within
the word processor. Move the cursor to the next location in the word processor and repeat.

Capture Direct To Clipboard:
Capture Professional can copy the captured image to the clipboard immediately after being captured.

Capture Direct To File:
Capture Professional can copy the captured image directly to a file. Capture Professional displays the Save dialog to prompt for
the name and details for each image (unless AutoNaming feature is being used.)

Capture Direct To Printer: Capture Professional can print the image. The Print dialog will appear, allowing for the image to
be formatted within the page.



Threshold vs. Dither vs. Scatter

Capture Professional uses three different techniques to are many opportunities to reduce a color or grayscale image to black and
white.  Examples of these techniques, Threshold, Dither and Scatter, are displayed below.
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Using the Timer

Capture Professional can optionally use a timer for capturing one or more images. When using the timer, the image to be
captured is selected normally. The number of images captured is set in the Use the timer to capture edit box on the
General/Timer page of the Preferences dialog. The first image is captured after the number of seconds in the Time before first
capture edit box. Any subsequent images are captured after the number seconds in the Time between captures edit box. The
Capture Professional main window will reappear after the last image is captured.

Once the timer is started a ticking sound will be heard, if the Enable Sound check box is checked on the General/Timer page of
the Preferences dialog. Using the Show Window hotkey will stop the timer.

For example:
In the General/Timer page of the Preferences dialog, if
the Use the timer to capture = 4 images and
the Time before first capture = 5 seconds and
the Time between captures = 3 seconds.
Then:
The first image will be captured after 5 seconds.
The second image will be captured after 8 seconds.
The third image will be captured after 11 seconds.
The fourth image will be captured after 14 seconds.
The Capture Professional main window will reappear containing 4 new images after 14 seconds.



Hotkeys

Capture Professional has thirteen user-configurable hotkeys. A hotkey is a key combination that can be accessed from any
application. If a hotkey conflicts with another application’s normal keystrokes or hotkey or don’t suit personal preference, it can
be changed or disabled on the Hotkey Setup page of the Preferences dialog.

Example: By default, the rectangle mode hotkey is CTRL + SHIFT + ‘R’. To use this hotkey, hold down the CTRL and SHIFT
keys, press the ‘R’ key and then release all three keys.

Two pairs of capture modes share hotkeys by default. Active Client Area mode and Client Area mode share a key. Active
Window mode and Window mode also share a hotkey. The active mode differs because it includes the ALT key. This is
intended to make the hotkeys easier to remember, but can be changed.

Of the thirteen hotkeys, twelve capture hotkeys invoke capture modes directly. The last hotkey is the Show Window hotkey
which brings the Capture Professional window to the top of the screen. It can be used at any time and can be used in
conjunction with the Hide On Minimize option. The Show Window hotkey cannot be disabled. The Show Window hotkey can
be used to abort capturing an image and to interupt capturing images with the timer .



Voluntary Options vs. Involuntary Options

Capture Professional has many configurable options.  These options can be grouped into two types.

Voluntary Options are set in the Preferences dialog. These are set by the user and are generally recognize as an option.
These options are saved automatically when Capture Professional is closed.

Involuntary Options are set in the Save dialog, the Open dialog and the Print dialog. These options are used to preserve the
last value. For example, a 256 color JPEG file is saved as C:\JPEG\imgl.jpg. The next time the File Save dialog is used to
save a new image, the directory will be set to C:\JPEG, the number of colors will be set to 256 and the file type will be set to
JPEG. These options are also saved when Capture Professional is closed



AutoNaming Files

Capture Professional can automatically name files using its AutoName feature. A four digit number, starting with “0000”, is
placed at the end of the file name for all files using this feature, including the first. When capturing and saving multiple images,
this feature saves time.

This feature is accessed from the Save dialog. When the AutoName check box is checked, the new AutoNamed file will appear
beneath it. For example, if the file specified is C:\SOMEDIR\APPL.BMP and the AutoName check box is checked, the dialog
will display APPL####.BMP, under the AutoName check box.

Only images without existing file names that are saved using the Eile/Save menu item, the toolbar's Save button or by the Direct
Save feature will be automatically named and saved. Selecting the File/Save As menu item will reset the AutoName feature,
ending the sequence. Afterwards, the next new image’s file name must be specified using the Save dialog. Choosing the
File/Reset AutoName menu item will also reset the AutoName feature.

Example Sequence:

Step 1. Capture a new image.

Step 2. Select the File/Save As menu item. Check the AutoName check box in the Save dialog.

Step 3. Save image as C:\Images\Art.BMP. The image is saved as C:\Images\Art0000.BMP

Step 4. Capture a new image.

Step 5. Select the File/Save menu item. The image is saved as C:\Images\Art0001.BMP

Step 6. Capture a new image.

Step 7. Modify the first image (the image that was C:\Images\Art0000.BMP)

Step 8. Save the firstimage. The image overwrites C:\Images\Art0000.BMP. This image is not automatically named
because it already has a file name.

Step 9. Select the second image window.

Step 10. Select the File/Save menu item. The image is saved as C:\Images\Art0002.BMP

Step 11. Select the File/Reset AutoName menu item.

Step 12. Capture a new image.

Step 13. Select the Eile/Save menu item. The Save dialog will appear because the AutoName feature is no longer
active.

Note: If the file system on a given drive only supports 8.3 file names, Capture Professional will add up to 4 digits to the file
name. The file name specified in the Save dialog must be seven characters or less.



Open Dialog

The Open dialog selects which image file to open. Capture Professional can open the following image formats (BMP, JPG,
PCX, PNG, TGA, TIF).

When a file is selected while the Files of type combo box is set to All Graphics Files, Capture Professional uses the file extension
to determine an image's format. To specify that an image is a certain type, select that image type from the Files of type combo
box.

For example, the extension for JPEG files is JPG. If a JPEG file is named "IMAGE.ABC", Capture Professional will not be able
to open it when the Files of type combo box is set to All Graphics Files. Setting the Files of type to JPEG files or renaming the
file to IMAGE.JPG will fix this problem.



How to Capture a Client Area

When using client area mode, Capture Professional can automatically scroll a client area with an enabled scroll bar to capture
the entire image. To use this feature, check the “Capture entire client area, automatically scrolling if necessary” check box on

the Capture Options page of the Preferences dialog.

Step 1. Select the Capture/Client Area menu item.
) . L ] |
-OR- Click the client area toolbar button ( ).
-OR- Use the client area hotkey sequence. The default hotkey sequence for client area capture is CTRL + SHIFT +

‘C’. To use this sequence: Press and hold the Control key. Press and hold the Shift key. Press the 'C' key. Then release all
three keys. This hotkey can be changed on the Hotkey Setup page.
e

Step 2. The cursor will turn into the client area capture cursor ( ). The client area of the window that the cursor is
over will be inverted.
Step 3. Move the cursor over the desired window. As the cursor moves from one window to the next, the old window will be

restored to its original condition and the next window will be inverted.
Step 4. Click the left mouse button to complete the capture. The client area will be captured immediately or optionally after the

duration of the timer.

Capturing a client area can be aborted at any time by pressing the escape key.



How to Capture an Image from the Clipboard

Step 1. Select the Edit/Paste As New Image menu item. This creates an image window with the contents of the
clipboard. This menu item is enabled only when the clipboard contains a bitmap or DIB (Device Independent
Bitmap).



How to Capture the Active Client Area

When using client area mode, Capture Professional can automatically scroll a client area with an enabled scroll bar to capture
the entire image. To use this feature, check the “Capture entire client area, automatically scrolling if necessary” check box on

the Capture Options page of the Preferences dialog.

Step 1. Select the Capture/Active Client Area menu item.
-OR- Use the active client area hotkey sequence. The default hotkey sequence for active client area capture is

CTRL + SHIFT + ALT + ‘C’. To use this sequence, press and hold the Control key, press and hold the Shift
key, press and hold the Alt key, press the 'C' key and thenrelease all four keys. This hotkey can be changed

on the Hotkey Setup page.

The image will be captured immediately or after the duration of the timer.



How to Capture the Active Window

Step 1. Select the Capture/Active Window menu item.
-OR- Use the active window hotkey sequence. The default hotkey sequence for active window capture is CTRL +

SHIFT + ALT + ‘W’. To use this sequence, press and hold the Control key, press and hold the Shift key,
press and hold the Alt key, press the ‘W' key and then release all four keys. This hotkey can be changed on

the Hotkey Setup page.

The image will be captured immediately or after the duration of the timer.



How to Capture the Entire Screen

Step 1. Select the Capture/Desktop menu item.
[
-OR- Click the desktop toolbar button (= ).

-OR- Use the desktop hotkey sequence. The default hotkey sequence for desktop capture is CTRL + SHIFT + ‘D’.
To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'D' key and then release all three keys.
This hotkey can be changed on the Hotkey Setup page.

The image will be captured immediately or after the duration of the timer.



How to Capture an Icon

Step 1.

-OR-

Step 2.
Step 3.
Step 4.
Step 5.

Select the Capture/lcon menu item.

Use the icon hotkey sequence. The default hotkey sequence for icon capture is CTRL + SHIFT + ‘I’.  To use
this sequence, press and hold the Control key, press and hold the Shift key, press the 'I' key and then release
all three keys. This hotkey can be changed on the Hotkey Setup page.

I . A
The cursor will turn into the icon capture cursor ( ).
Click and hold the left mouse button down. A small square that will appear.
Move the square over the desired image.

When square covers the image to be captured, release the left mouse button. The image will be captured
immediately or after the duration of the timer.

Capturing and icon can be aborted at any time by pressing the escape key.

When an image is captured in icon mode, the Save dialog will automatically default to the .ICO file format. This mode is a
convenience to those who capture icons frequently.



How to Capture a Circle or an Ellipse

Step 1.

-OR-

Step 2.
Step 3.
Step 4.
Step 5.

Step 6.

Select the Capture/Oval menu item.

Use the oval hotkey sequence. The default hotkey sequence for oval capture is CTRL + SHIFT + ‘O’. To
use this sequence, press and hold the Control key, press and hold the Shift key, press the 'O’ key and then
release all three keys. This hotkey can be changed on the Hotkey Setup page.

- o
The cursor will turn into the oval capture cursor ( D).
Move the cursor to any corner of the desired oval.
Click and release the left mouse button.
Draw the oval by dragging the cursor to the opposite corner of the desired oval. The oval can be moved at its
present size by holding down the right mouse button with the left mouse button.
When the image to be captured is covered by the oval, click and release the left mouse button. The oval is
captured immediately or optionally after the duration of the timer.

Capturing an oval can be aborted at any time by pressing the escape key.



How to Capture a Rectangle

Step 1. Select the Capture/Rectangle menu item.
-OR- Click the rectangle capture toolbar button (E).
-OR- Use the rectangle hotkey sequence. The default hotkey sequence for rectangle capture is CTRL + SHIFT +

‘R’. To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'R' key and release all three
keys. This hotkey can be changed on the Hotkey Setup page.

+
Step 2. The cursor will turn into the rectangle capture cursor ( ] ).

Step 3. Move the cursor to any corner of the desired rectangle.

Step 4. Click and release the left mouse button.

Step 5. Draw the rectangle by dragging the cursor to the opposite corner of the desired rectangle. The rectangle can be moved
at its present size by holding down the right mouse button with the left mouse button.

Step 6. When the image to be captured is covered by the rectangle, click and release the left mouse button. The rectangle is
captured immediately or optionally after the duration of the timer.

If the Fixed Size check box on the Capture Options page of the Preferences dialog is checked, a rectangle of fixed size will
appear after step 3. The fixed size rectangle will have the size specified by the X and Y edit boxes on the same dialog.

Capturing a rectangle can be aborted at any time by pressing the escape key.



How to Capture a Polygon

Step 1.

-OR-

Step 2.
Step 3.
Step 4.
Step 5.
Step 6.

Step 7.

Select the Capture/Polygon menu item.

Use the polygon hotkey sequence. The default hotkey sequence for polygon capture is CTRL +
SHIFT + ‘P’.  To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'P’
key and then release all three keys. This hotkey can be changed on the Hotkey Setup page.

The cursor will turn into the polygon capture cursor ( ﬂ').

Set the first point of the polygon by pressing the left button at that location.

Release the left mouse button.

Move the cursor to the next point. As the cursor moves, a line will be drawn from the first point to the cursor.

Set each point by pressing the left mouse button down and releasing it when the cursor is at the desired
location. Holding down the right mouse button while moving the mouse can move the polygon.

Double click on the final point or hold down the SHIFT key and click the left mouse button down on the final
point ends the polygon capture mode. Capture Professional captures the polygon immediately or optionally
after the duration of the timer.

Capturing a polygon can be aborted at any time by pressing the escape key.



How to Capture a Window

Step 1. Select the Capture/Window menu item.
-OR- Click the window capture toolbar button (@)
-OR- Use the window hotkey sequence. The default hotkey sequence for window capture is CTRL + SHIFT + ‘W’.

To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'W' key and release all three keys.
This hotkey can be changed on the Hotkey Setup page.

+
Step 2. The cursor will turn into the window capture cursor ( w). The window that the cursor is over will be inverted.
Step 3. Move the cursor over the desired window. As the cursor moves from one window to the next, the old window will be
restored to its original condition and the next window will be inverted.
Step 4. Click the left mouse button to complete the capture. The window will be captured immediately or optionally after the
duration of the timer.

Capturing a window can be aborted at any time by pressing the escape key.



How To Automatically Name Files

Capture Professional can sequentially name files. This is very simple to accomplish.

Step 1.
Step 2.
Step 3.

Step 4.

Step 5.
Step 6.
Step 7.
Step 8.
Step 9.

Step 10.
Step 11.
Step 12.
Step 13.

Capture the first image.
Select the Eile/Save menu item.

In the Save dialog, type the file name in the file name edit box. Be sure that the file name is seven less
characters or less before the dot.

Check the AutoName check box. The name of the file followed by four #’s will appear below the check box.
For example, TEST.BMP becomes TEST####.BMP

Click on Ok.

The first file will be saved. In our example it will be TEST0000.BMP.
Capture the next image.

Select the Eile/Save menu item.

The next image will be saved. In our example it will be TEST0001.BMP.
Capture the next image.

Select the Eile/Save menu item.

The next image will be saved. In our example it will be TEST0002.BMP.
And so on....

To start naming the files under another name, use the Eile/Save menu item to save an image. Or click on the File/Reset
AutoName menu item and the next time a new image is saved, the Save dialog will appear.




How to Capture a DOS Screen

Capture Professional can capture any DOS screen that can be run in a DOS Window.

Step 1.
Step 2.
Step 3.

Step 4.

Run the DOS application.

If the DOS application is full screen, hold down the ALT key and press ENTER.

The DOS application should now be in a window. If it is not, Capture Professional can ‘t work with this DOS
application.

Use Active Client Area mode to capture the DOS Prompt window.



License Agreement

Capture Professional -
SINGLE USER LICENSE AGREEMENT

Read this license carefully before use.

You are purchasing a license to use the Capture ProfessionalTM Software. The Software is owned and remains
the property of Creative Softworx and is protected by international copyrights, and is transferred to the original
purchaser and any subsequent owner of the Software media for their use only under the license terms set forth
below. Opening the packaging and / or using the Software indicates your acceptance of these terms. If you do
not agree to all of the terms and conditions, return the Software and all manuals within 30 days of purchase to the
party from whom you received it for a refund, subject to our restocking fee.

Grant of License

Creative Softworx grants the original purchaser (Licensee) the limited rights to possess and use the Creative
Softworx Capture ProfessionalTM Software (Software) and Getting Started guide, on the terms and conditions
specifically set out in this license.

Term

This License is effective as of the time Licensee receives the Software, and shall continue in effect until Licensee
ceases all use of the Software and returns or destroys all copies thereof, or until automatically terminated upon the
failure of Licensee to comply with any of the terms of this License.

Single User License
The Software is provided under a Single User License. This means that only one specific individual is licensed to
install and use the Software. That specific individual may also use the Software on a portable or home computer.

A single user license may not be installed on a network.

Multiple Users
If you want to install the Software on a network and provide access for more than one specific user, you

can purchase additional licenses which can be purchased in 5, 10, 20 and 100 denominations. Each
license allows the corresponding number of specific individuals to use the software.

For example, for 5 users to be able to use the Software, you must purchase 5 total licenses, even if the
users would not use the software concurrently.

One machine-readable copy of the Software may be made for BACK-UP PURPOSES ONLY, and the copy shall
display all proprietary notices, and be labeled externally to show that the back-up copy is the property of Creative
Softworx and its use is subject to this license. Documentation in whole or part may not be copied in any form.

Licensee may transfer its rights under this License, PROVIDED that the party to whom such rights are transferred
agrees to the terms and conditions of the License, and written notice is provided to Creative Softworx. Upon such
transfer, Licensee must transfer or destroy all copies of the Software.

Except as expressly provided in this license, Licensee may not use, copy, disseminate, modify, distribute, sub-
license, sell, rent, lease, lend, give or in any other way transfer, by any means or in any medium, including
telecommunications, the Software. Licensee will use their best efforts and take all reasonable steps to protect the
Software from unauthorized use, copying or dissemination, and will maintain all proprietary notices intact.

For diskettes containing multiple versions of Capture Professional, this agreement shall encompass all versions.
The different versions of Software cannot be split in any way or form.

DISCLAIMER
LICENSE FEES FOR THE SOFTWARE DO NOT INCLUDE ANY CONSIDERATION FOR ASSUMPTION OF
RISK BY CREATIVE SOFTWORX AND CREATIVE SOFTWORX DISCLAIMS ANY AND ALL LIABILITY FOR



INCIDENTAL OR CONSEQUENTAL DAMAGES ARISING OUT OF THE USE OR OPERATION OR INABILITY TO
USE THE SOFTWARE, OR ARISING FROM THE NEGLIGENCE OF CREATIVE SOFTWORX OR ITS
EMPLOYEES, OFFICERS, DIRECTORS, CONSULTANTS OR DEALERS, EVEN IF ANY OF THESE PARTIES
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. FURTHERMORE, LICENSEE
INDEMNIFIES AND AGREES TO HOLD CREATIVE SOFTWORX HARMLESS FROM SUCH CLAIMS. THE
LICENSEE ASSUMES THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THIS SOFTWARE.
THE WARRANTIES EXPRESSED IN THIS LICENSE ARE THE ONLY WARRANTIES MADE BY CREATIVE
SOFTWORX AND ARE IN LIEU OF ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING BUT
NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND OF FITNESS FOR A PARTICULAR
PURPOSE.



Site Licensing

Pricing for Multiple User Versions of Capture Professional 3.0 are as follows.

5 User $100.00
Other pricing Call 800-680-9679 or email mmazurik@creativesoftworx.com



Open Menu Item

Select the Open menu item or the Open toolbar button (El) to open an image file with the Open dialog. This menu item is
found on the File menu.



Save Menu ltem

Select the Save menu item or the Save toolbar button (El) to save the current image. This menu item is located on the Eile
menu.

If the image has a file name, the Save menu item will save the current image using its current file name, color depth and
compression.

If the image does not have a file name and the AutoName option IS NOT being used, the Save dialog will appear. Under these
conditions, this is identical to selecting the Save As menu item .

If the image does not have a file name and the AutoName option IS being used, the file will be automatically named to the next
file name in the sequence. For example, if the last image was saved as "C:\TEMP\FILE.BMP", the current image will be saved
as "FILE2.BMP". The file will be saved in the same file format, number of colors, and compression scheme of the first image
saved with the AutoName option.



Save As Menu Item

Select the Save As menu item to save an image with the Save dialog. This menu item is located on the Eile menu.



Reset AutoName Menu Item
Select the Reset AutoName menu item to reset the AutoName function. This will cause the Save dialog to appear the next time
the Save menu item is selected for an image that has not been saved. This menu item is located on the Eile menu.

The Reset AutoName menu item is enabled only when the AutoName option is used.



Print Menu ltem

Select the Print menu item or the Print toolbar button (@) to print the current image using the Print dialog. This menu item is
located on the Eile menu.



Print Setup Menu Item

Select the Print Setup menu item to configure various printer settings with the Print Setup dialog. These settings are only used
by Capture Professional and last only as long as Capture Professional is running. This menu item is located on the Eile menu.



Preferences Menu Item

Selecting on the Preferences menu item will cause the Preferences dialog to appear. This will allow the user to change all of
the configurable options of Capture Professional. This menu item is located on the Eile menu.



Exit Menu ltem

Select the Exit menu item to close Capture Professional. If there are multiple images that have not been saved (or have been
changed since they were saved), a message box will appear, prompting if ANY of the images should be saved.

Choosing YES to the first message box will cause another message box to appear for each unsaved image. The
second message box prompts the user to save each unsaved or editted image.

Choosing YES to the second message box as if the Save menu item had been selected from the File menu.
Choosing NO will cause the current image or its changes to be lost.
Choosing CANCEL will cause the exit to abort. Any images that have already been closed will be lost.

Choosing NO to the first message box will cause Capture Professional to exit without saving any images.
Choosing CANCEL will keep Capture Professional from exiting.

This menu item is located on the File menu.



Undo Menu Item

Select the Undo menu item to undo the last action performed on the current image. This menu item is located on the Edit menu
and is disabled if there is not an action to undo. After this menu item is selected, it may take several seconds to recalculate the
current image.




Copy Menu Item

Select the Copy menu item to copy the current image to the clipboard.



Paste As New Image Menu Item

Select the Paste As New Image menu item to create a new image window containing the bitmap in the clipboard. This menu
item is disabled if the clipboard does not contain a bitmap.



Copy To Application Menu Item

Select the Copy To Application menu item to copy the current image to the specified application. This menu item is enabled
when an application has been found to work with Capture Professional.

To find the application, select the Find Application menu item on the Edit menu or the Find Application button on Capture Options
page of the Preferences dialog. After an application is found, this menu item will contain the application name. For example, if
the link is with Microsoft Word, this menu item will read Copy To Microsoft Word.



Find Application Menu Item
Select the Find Application menu item to cause the Choose Application dialog to appear.



Select All Menu Item

Select this menu item to remove the selected area from the current image. This menu item is located on the Edit menu. The
selection can also be removed with the Selection Toal.



Purge Undo Menu Item

Select the Purge Undo menu item to free memory associated with editing the current image. After the Purge Undo menu item is
selected, edits to the current image are made permanent. The Purge Undo menu item is located on the Edit menu. This item is

grayed out when there are not actions to undo.



Zoom 100% Menu Item

To view an image at its actual size, select the View/Zoom 100% menu item or click the Zoom 100% toolbar button (@). If
this toolbar button appears pressed in, the image is being displayed at 100% scale.




Zoom: 25% Menu Item

To view an image at one quarter of its actual size, select the View/Zoom 25% menu item or click the Zoom 25% toolbar button (

a|

). If this toolbar button appears pressed in, the image is being displayed at 25% scale.



Zoom: 50% Menu Item

To view an image at one half of its actual size, select the View/Zoom 50% menu item or click the Zoom 50% toolbar button (

a ). If this toolbar button appears pressed in, the image is being displayed at 50% scale.



Zoom: 200% Menu Item

To view an image at twice its actual size, select the View/Zoom 200% menu item or click the Zoom 200% toolbar button (gl).
If this toolbar button appears pressed in, the image is being displayed at 200% scale.




Zoom: 400% Menu Item

To view an image at four times its actual size, select the View/Zoom 400% menu item or click the Zoom 400% toolbar button (

@ ). If this toolbar button appears pressed in, the image is being displayed at 400% scale.



Zoom: 800% Menu Item

To view an image at its actual size, select the View/Zoom 800% menu item or click the Zoom 800% toolbar button (ﬁl). If
this toolbar button appears pressed in, the image is being displayed at 800% scale.




Toolbar

Clicking on the Toolbar menu item toggles whether the tool bar is visible. If the tool bar is visible, there will be a checkmark next
to the menu item.



Threshold Menu ltem

Select the Threshold menu item to begin blurring the current image. This menu item is located on the Effects/Blur menu.




Contrast Menu Item
Select the Contrast menu item to begin adjusting the current image's contrast. This menu item is located on the Effects menu.



Crop Menu Item

. . =0
Select this menu item or click on the Crop toolbar button (J) to apply the crop operation to the current image. This menu
item is found on the Operations menu.



Equalize Menu Item
Select the Equalize menu item to equalize the current image's brightness levels. This menu item is located on the Effects menu.



Invert Menu Iltem

Select the Invert menu item to invert the current image. This menu item is located on the Effects menu.



Outline Menu Item

Select the Outline menu item to outline the current image. This menu item is located on the Effects menu.



Pixelize Menu Item

Select the Pixelize menu item to begin pixelizing the current image. This menu item is located on the Effects menu.



Posterize Menu Item

Select the Posterize menu item to begin posterizing the current image. This menu item is located on the Effects menu.



Remove Noise Menu Item

Select the Remove Noise menu item to remove random noise from the current image. This menu item is located on the Effects
menu.



Cascade Menu Item

Select the Cascade menu item to stack all image windows, overlapping them so that each is the same size as all others and only
part of each underlying window is visible. This menu item is located on the Window menu.



Tile Horizontal Menu Item

Select the Tile Horizontal menu item to arrange non-minimized image windows within the MDI client area so that they cover the
entire width of the desktop without overlapping one another. Image windows are stacked from the top to the bottom of the MDI

client window. This means that image windows generally become wider than tall. This menu item is located on the Window
menu.



Tile Vertical Menu Item

Select the Tile Vertical menu item to arrange non-minimized image windows within the MDI client area so that they cover the
entire width of the desktop without overlapping one another. Image windows are stacked from the left to the right of the MDI

client window. This means that image windows are generally become taller than wide. This menu item is located on the Window
menu.



Arrange Icons Menu Item

Select the Arrange Icons menu item to arrange minimized image windows on the bottom of the MDI client window. The
rearranged icons are evenly spaced, beginning at the lower left corner of the MDI client window. This menu item is located on the

Window menu.



Close All Menu Item

Select the Close All menu item to close all image windows. If images have not been saved or have changed since being saved,
a prompt will be displayed for saving those images. See the FEile/Exit for more details. This menu item is located on the
Window menu.



Minimize All Menu ltem

Select the Minimize All menu item to minimize all image windows. This menu item is located on the Window menu.



Help Topics Menu Item

Select the Contents menu item to display the Contents section of this help file. This menu item is located on the Help Menu.
The About menu item displays the version information and copyright information in the About dialog.



True Color Menu ltem

Select the True Color menu item or click the True Color toolbar button (ﬁl)) to convert the current image to 24-bit color. This

menu item is located on the Operations/Convert To menu. When the True Color toolbar button is displayed depressed, the
current image is a true color image.



Palette Color Menu Item

Select the Palette Color menu Item or click the Palette Color toolbar button (ﬁl} to convert the current image to 8-bit color.
This menu item is located on the Operations/Convert To menu. When the Palette Color toolbar button is displayed depressed,
the current image is a palette color image.



Grayscale Menu Item

Select the Grayscale menu Item or click the Grayscale toolbar button (ﬂl) to convert the current image to 256 shades of gray.
This menu item is located on the Operations/Convert To menu. When the Grayscale toolbar button is displayed depressed, the
current image is a grayscale image.



Black & White Menu Item

Select the Black & White menu item or click the Black & White toolbar button (Ll) to convert the current image to black and
white. This menu item is located on the Operations/Convert To menu. When the Black & White toolbar button is displayed
depressed, the current image is a black and white image.



Change Menu Item

Select the Change menu item or the Change Brightness toolbar button (El) to change the current image's brightness. This
menu item is found on the Effects/Brightness menu.




Limit Menu Item

Select the Limit menu item to begin limiting the current image's brightness. This menu item is found on the Effects/Brightness
menu.




Midrange Brighten Menu Item

Select the Midrange Brighten menu item to brighten the intermediate brightness levels within the current _image. This menu item
is found on the Effects/Brightness menu.




Horizontal Menu Iltem
Select the Horizontal menu item to flip an image left to right. This menu item is found on the Operations/Flip menu.



Vertical Menu Item
Select the Vertical menu item to flip an image top to bottom. This menu item is found on the Operations/Flip menu.



90° Clockwise Menu Item

Select the 90° Clockwise menu item or click the Rotate 90° Clockwise toolbar button (E) to rotate the image 90 degrees
clockwise. This menu item is located on the Operations/Rotate menu.




90° Counter-Clockwise Menu Item

Select the 90° Counter-Clockwise menu item or click the Rotate 90° Counter-Clockwise toolbar button (ﬂ) to rotate the image
90 degrees counter-clockwise. This menu item is located on the Operations/Rotate menu.



Any Angle Menu Item

Select the Any Angle menu item to begin rotating the current image in one degree increments. This menu item is located on the
Operations/Rotate menu.



Enter Serial Number Menu Item

Select the Enter Serial Number menu item to register a demo copy of Capture Professional with the Registration dialog. This
menu item is only visible in the demo version of Capture Professional. This menu item is located on the Help menu.



Increase Image Size Dialog

The Increase Image Size dialog is used to add width or height to the current image. The behavior is described in the following
table.

Add To Increases Image Shift
Left Width by amount Right
Top Height by amount Down
Right Width by amount None
Bottom Height by amount None

To decrease the size of the image, use the Crop effect instead of the Increase Image Size effect.



Enter the image's vertical file resolution in the Y edit box. The value in the Units combo box determines whether the vertical
resolution is expressed in centimeters or inches. This file setting is only used by other applications that may use this file and
does not affect of the image within Capture Professional. This edit box is visible for Bitmap, PCX and TIFF file types.



To increase the current image’s height, add the new height to the top and move the existing image down, select this radio button.



To increase the current image’s width, add the new width to the left and move the existing image to the right, select this radio
button.



To increase the current image’s width and not move the existing image, select this radio button.



To increase the current image’s height, add the new height to the bottom and not move the existing image, select this radio
button.



Enter the number of additional pixels to add to the current image.

To decrease the size of the current image, use the Crop effect instead of the Increase Image Size effect.



To decrease the number of additional pixels to add to the current image, move this slider to the left. To increase the number of
additional pixels to add to the current image, move this slider to the right.

To decrease the size of the image, use the Crop effect instead of the Increase Image Size effect.



To close this dialog box without accepting any changes and to revert the image to its previous state, click this button.



To close this dialog box and accept any changes to the current image, click this button.



To display general-purpose help for this dialog, click this button.



Edge Emphasis Dialog

The Edge Emphasis dialog is used to select edge-emphasizing filters to the current image or selected area of the current image.
Three settings are used to create the filter: direction, direction type and amount of emphasis.

Direction determines which pixels are used to increase contrast between differing pixels. Selecting the North or South direction
will emphasize horizontal lines within the current image. Selecting the West or East direction will emphasis vertical lines within
the current image. Northwest, northeast, southwest and southeast will highlight their respective diagonal lines.

Direction Type also determines which pixel are used to increase contrast. Exact only uses pixels in the selected direction and
the exact opposite direction. General uses all pixels of the selected direction and all pixels of the opposite direction.
Combination uses all pixels of the selected and opposite directions, but weights the exact selected and opposite directions so
that they are the predominant influence.

Emphasis determines the amount of increased contrast that is created between differing pixels.



To emphasize horizontal lines, select this radio button.



To emphasize vertical lines, select this radio button.



To emphasize diagonal lines that move down as they move right, select this radio button.



To emphasize horizontal lines, select this radio button.



To emphasize diagonal lines that move up as they move right, select this radio button.



To emphasize vertical lines, select this radio button.



To emphasize diagonal lines that move down as they move right, select this radio button.



To use only the exact pixel and exact opposite pixels for edge emphasis, check this radio button.



To use the pixels in the general direction and general opposite pixels for edge emphasis, check this radio button.



To use the pixels in the general direction and general opposite pixels, but to weight the exact direction and the exact opposite for
greater effect for edge emphasis, check this radio button.



Enter the amount to increase contrast between pixels in the selected direction.



Move this slider to the right to increase the amount of contrast between pixels in the selected direction. To decrease the amount
of contrast between pixels in the selected direction, move this slider to the left.



Extract Dialog

The Extract dialog is used to open resource images (bitmaps, icons and cursors) that are embedded in many 32-bit Windows
executables and DLL’s. Not all EXE’s or DLL’s have resources in them. At this time, Capture Professional cannot extract
resources from 16-bit executables.

The Extract dialog lists all images within each 32-bit executable in the Images Found list box. The selected resource in the
Images Found list box is displayed in the Preview area of the dialog. The list of resources in the Images found dialog can be
filtered by selecting one of the Img. Type radio buttons.

The Extract dialog generally works like a standard File Open dialog box, but an image must be selected in the Images Found list
box before the Extract button will close the dialog. Also, double-clicking on a file in “files” list view will not close the dialog box.



To extract a given image resource, select it in this list box. The currently selected item in this list box will be displayed in the
preview area of this dialog.

Some resources may have meaningful identifiers (SPLASHSCREEN.BMP), but most can only be identified by a number
(1.BMP).



This area of the dialog displays the image that is selected in the Images Found list box. As many resources do not have
meaningful names, this will help in finding the desired image.



To list bitmap, icon and cursor resources in the Images Found list box, check this radio button.



To list only bitmap resources in the Images Found list box, check this radio button.



To list only icon resources in the Images Found list box, check this radio button.



To list only cursor resources in the Images Found list box, check this radio button.



File Properties Page

This page appears in the Properties dialog only if the image has been saved to a file or opened from an existing file. It gives
information on the file attributes and can edit the resolution of an image in TIFF format.



This static text box contains the file name of the current image.



This static text box contains the file type of the current image.



This static text box contains the file depth (in bits) of the current image.



This static text box contains the file compression scheme of the current image, if any.



To change the unit of measurement for the current TIFF file, select the desired unit of measurement from this combo box.



To change the horizontal resolution for the current TIFF file, enter the desired horizontal resolution in this edit box. The unit of
measurement is determined in the Unit of Measurement combo box.



To change the vertical resolution for the current TIFF file, enter the desired vertical resolution in this edit box. The unit of
measurement is determined in the Unit of Measurement combo box



Image Properties Page

The Image page always appears in the Properties dialog. It provides information about many image characteristics. This page
is for informational purposes only.



This static text box contains the type of the current image: Normal or Transparent.



This static text box contains the width of the current image in pixels.



This static text box contains the height of the current image in pixels.



This static text box contains the bit depth of the current image.



This static text box contains the number of possible colors in the current image.



This static text box contains the size of the image in bytes. This figure includes the memory used by the current image and the
transparent layer of that image, if any.



This static text box contains the total amount of memory associated with the currentimage. This figure includes the memory
used by the current image, the current transparent layer (if any), the initial image (if any), the initial transparent layer (if any), the
draw buffer (if any) and the transparent draw buffer.



This static text box contains the number of actions that are currently applied to the image that can be undone.



This static text box contains the number of undone actions that can be re-applied to the current image.



Capture Professional Features

Welcome to Capture Professional 3, the most flexible and powerful screen capture program available. Capture Professional
allows all or a selected portion of the screen to be captured simply and easily.

Capture Professional has eleven capture modes plus a Menu Capture Wizard. Each capture mode grabs images from the

screen in a unique way and has its own customizable hotkey for quick access. The following capture modes are part of Capture

Professional: Active Client Area, Active Window, Client Area, Control, Desktop, Icon, Menu, Oval, Rectangle, Polygon and

Window.

. Once an image is captured it can be touched up. Capture Professional has over 20 effects that can be applied to all or
a rectangular area of the image, including conversion to grayscale, pixelization, cropping, outlining, rotation, inversion
and five ways to change the brightness.

. Then an image can be saved in one of nine file formats (BMP, EPS, ICO, JPG, PCX, PNG, RLE, TGA or TIF) and in one
of four color depths (2 Color, 16 Color, 256 Color or 16.7 Million Colors).

3 Or the image can be copied to the clipboard or even to straight to another application.

3 Or the image can be printed using Capture Professional’s new printing interface which can scale the image to the page
or use a user defined scale, width or height.

. Capture Professional can also open seven file formats (BMP, GIF, JPG, PCX, PNG, TGA, or TIF) whether these images

are opened using Capture Professional’s Open dialog or dragged onto its window from File Manager or Explorer.



Create New Image Dialog

The Create New Image dialog is used to create a blank image for that can be drawn on. In this dialog the new image’s initial
width, height and color depth are chosen.



To set the new image’s width, enter the desired width in this edit box or use the spin button to get to the desired width. The
image’s width is measured in pixels.



To set the new image’s height, enter an image in this edit box or use the spin button to get to the desired height. The image’s
height is measured in pixels.



To create an 24-bit True Color image, check this radio button. True color images take up the most memory and disk space, but
are capable of containing the most photo-realistic images.



To create an 256 color image, check this radio button. Any 256 colors can be chosen for this image.



To create an image with 256 shades of gray, check this radio button.



To create an image that can only be composed of black and white pixels, select this radio button. Black and white images use
the least amount of memory.



To create the image, click this button.



To abort creating a new image, click this button.



To emphasize diagonal lines that move up as they move right, select this radio button.



Undo/Redo Actions Dialog

The Undo/Redo Actions dialog is used to undo or redo actions. Any action can be undone or redone. For example, the first
action can be undone and leave all subsequent actions unaffected. After actions are undone or redone, the entire image is
recalculated for display. The amount of time required to recalculate an image will depend on the number and type of enabled
actions for an image.

The multi-column list view lists actions in the first column and their status in the second column. Statuses that are changed
while this dialog is open are displayed in “UPPERCASE”. Statuses that have not been changed while this dialog is open will
appear in “Mixed Case”.

Pressing the Undo button will disable all selected and enabled actions. This has no effect on currently disabled actions.

Pressing the Redo button will redo all selected and disabled actions. This has no effect on currently enabled actions.




Action

Capture Professional Definition: Any drawing tool, operation, effect or macro applied to an image.



Click this button to disable all selected and enabled actions. This has no effect on currently disabled actions.



Click this button to enable all selected and enabled actions. This has no effect on currently enabled actions.



Click this button to close the dialog. Any actions that have been undone or redone will remain undone or redone.



This list view contains a list of all actions of the selected image and their current status. Select one or more actions to be
undone or redone using the Undo or Redo buttons.

To select and image, click the first column of the given actions. Hold down the control key to select multiple actions.



Select the Fit To Max Page radio button to size the printed image to the maximum that will fit on the page while maintaining an
identical horizontal and vertical scale. This print option will override the specified margins and instead use the selected printer's
minimum margins.



Choose Font Dialog

The Choose Font dialog is used to select a font for the text tool. The chosen font is used for drawing new text with the text tool.
Previously drawn text will display in their previous font.




Choose Custom Color Dialog

The Choose Custom Color dialog is used to choose a new foreground or background color to be used for drawing on the current
24-bit color image. Optionally, this dialog can be used to select one of the sixteen quick access colors displayed on left side of
the 24-bit color bar by using the Add to Custom Colors button.

To invoke this dialog, double click on the foreground or background color portion of the color bar. This dialog is only available
for 24-bit images.



Redefine Palette Color Dialog

The Redefine Palette Color dialog is used to replace a color in a 256-color image with another color. If successful, any pixel of
the previous color will be changed to the new color. Replacing an unused color will allow a new color to be drawn on the image.

To invoke this dialog, double click on the desired palette color/index in the palette portion of the color bar. This dialog is only
available for 8-bit color (non-grayscale) images.



To unlock Capture Professional after purchase, enter the name, company name and serial number provided by Creative
Softworx. Click this button after information has been completely entered.



To run Capture Professional in demo mode, click this button. All images that are saved, copied or printed will have random
banners randomly placed through the image.



Open File Dialog
The Open File dialog is used to create an image window from an existing file. Capture Professional can open the following file
formats: BMP, JPG, PCX, PNG, TGA, and TIF.

Note: The above file formats can be opened by dragging them from Explorer or File Manager onto any Capture Professional
window.



Status Bar
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The status bar normally contains seven information areas.

1.

Information Area

Zoom Area

Image Size Area

Transparent Area

Modified Area

Memory Size Area

. Undo Count Area

This area contains informational text at various times. For example, the pick color tool uses this
area to display the red, green and blue characteristics of the current pixel.

This area contains the zoom factor of the current image as a percentage. Possible values are
25%, 50%, 100%, 200%, 400% or 800%.

This area contains the width and height of the current image in pixels.

This area contains “Trans” if the current image contains a transparent layer. Otherwise, this area
is left blank

This area contains “Mod” if the current image has not been saved or changes have been made
after the current image was last saved.

This area contains two pieces of information. The first part is the amount of memory that the
current image requires. The second part is the total amount of memory used by the current image
including any memory used for drawing and for storing undo information.

This area contains the number of actions that have been applied to the current image.




Tool Palette
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Click on areas of the above tool palette for more information.

The tool palette is used to select the current drawing tool for the currentimage. Depending on the current drawing tool, line width,
line style and/or fill style can also be selected.

Each image has drawing tool, line width, line style and fill style settings. Selecting another image will cause the tool palette to
display the settings for the new image.



Selection Tool

Effects can be applied to the current image or a rectangular area of the currentimage. The selected area can also be moved or

copied by draging the selected area or copied to the clipboard.

To select a rectangular area of an image:

Step 1. If the selection tool button ( )is not depressed, press the selection tool
Step 2. Click the left mouse button on a corner of the desired rectangular area.
Step 3. Drag the cursor to the opposite corner of the desired rectangular area.
Step 4. Release the left mouse button.

To remove the selection area:

Step 1.

-OR-

Right click on the image
Select the Edit/Select All menu item.

To move the selected area:

Step 1. Select the desired rectangular area.

:_
Step 2. Move the cursor into the selected rectangle. The cursor will change to G@D
Step 3. Press and hold the left mouse button down.
Step 4. Move the selected image to the desired location.
Step 5. Release the left mouse button.

To copy the selected area:

Step 1. Select the desired rectangular area.

Step 2. Move the cursor into the selected rectangle. The cursor will change to
I

Step 3. Press and hold the control key down. The cursor will change to E,

Step 4. Press and hold the left mouse button down.

Step 5. Move the selected image to the desired location.

Step 6. Release the left mouse button.

Step 7.

Release the control key

button on the Tool Palette.




Pick Color Tool

The pick color tool selects a foreground or background color for drawing.
To pick the foreground color:

Step 1. If the pick color tool button (ﬁ) is not depressed, press the pick color tool button on the Tool Palette.
Step 2. Click the left mouse button on the desired color within the image. The chosen color will appear in the color palette in the
foreground color well. The chosen color’s red, green and blue components will appear in the information area of the status bar.
Step 3. Dragging the cursor around the image will choose another color.

Step 4. Release the left mouse button when the desired color appears in the foreground color well.

To pick the background foreground color:

Step 1. If the pick color tool button
Tool Palette.

Step 2. Click the right mouse button on the desired color within the image. The chosen color will appear in the color palette in
the foreground color well. The chosen color’s red, green and blue components will appear in the information area of the status bar.
Step 3. Dragging the cursor around the image will choose another color.

Step 4. Release the right mouse button when the desired color appears in the foreground color well.

) is not depressed, press the pick color tool button on the



Fill Tool

The fill tool fills an area of an image with the foreground or background color.  The area filled follows the border of the color that
is clicked on.

To fill an area using the foreground color:

Step 1. If the fill tool button (@) is not depressed, press the fill tool button on the Tool Palette.
Step 2. Click the left mouse button within the desired area.

To fill an area using the background color:

Step 1. If the fill tool button (
Step 2. Click the left mouse button within the desired area.

) is not depressed, press the fill tool button on the Tool Palette.



Draw Tool
The draw tool draws freehand lines with the foreground color. This tool uses the tool palette’s line width setting.

To draw a freehand line:

Step 1. If the draw tool button (ﬂ) is not depressed, press the draw tool button on the Tool Palette.

Step 2. Click the left mouse button at the start of the desired freehand line.
Step 3. Move the mouse along the path of the desired freehand line.
Step 4. Release the mouse button when done.

To abort drawing a freehand line:
Step 1. While drawing, press the right mouse button.
-OR- Press the Escape (ESC) key.



Line Tool

The line tool draws straight lines with the foreground color. This tool uses the tool palette’s line width and line style settings.
To draw a straight line:

Step 1. If the line tool button (d) is not depressed, press the line tool button. on the Tool Palette

Step 2. Click the left mouse button at the start of the desired line.
Step 3. Move the mouse to the end of the desired line.
Step 4. Release the mouse button when done.

To abort drawing a straight line:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Arrow Tool

The arrow tool draws a straight line with an arrow head with the foreground color. This tool uses the tool palette’s line width and

ine style settings.

To draw an arrow:

Step 1. If the arrow tool button (ﬂ) is not depressed, press the arrow tool button on the Tool Palette.

Step 2. Click the left mouse button at the end of the desired arrow.
Step 3. Move the mouse to the point of the desired arrow.
Step 4. Release the mouse button when done.

To abort drawing an arrow:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Hollow Rectangle Tool

The hollow rectangle tool draws a hollow rectangle or square using the foreground color. This tool uses the tool palette’s line
width and line style settings.

To draw a hollow rectangle:

Step 1. If the hollow rectangle tool button (g) is not depressed, press the hollow rectangle tool button on the Toaol
Palette.
Step 2. Click the left mouse button at one corner of the desired rectangle.
Step 3. Move the mouse to the opposite point of the desired rectangle.
Step 4. Release the mouse button when done.

To draw a hollow square:

Step 1. If the hollow rectangle tool button (i ) is not depressed, press the hollow rectangle tool
button on the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the square to equal with width.

Step 3. Click the left mouse button at one corner of the desired square.

Step 4. Move the mouse to the opposite point of the desired square.

Step 5. Release the mouse button when done.

To abort drawing a rectangle or square:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Filled Rectangle

The filled rectangle tool draws a rectangle or square using the foreground color for rectangle’s border and the background color
for the inside fill color. This tool uses the tool palette’s line width, line style and fill style settings.

To draw a filled rectangle:

Step 1. If the filled rectangle tool button (E) is not depressed, press the filled rectangle tool button on the Tool
Palette.
Step 2. Click the left mouse button at one corner of the desired rectangle.
Step 3. Move the mouse to the opposite point of the desired rectangle.
Step 4. Release the mouse button when done.

To draw a filled square:

Step 1. If the filled rectangle tool button ) is not depressed, press the filled rectangle tool
button on the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the square to equal with width.

Step 3. Click the left mouse button at one corner of the desired square.

Step 4. Move the mouse to the opposite point of the desired square.

Step 5. Release the mouse button when done.

To abort drawing a rectangle or square:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Solid Rectangle Tool

The solid rectangle tool draws a solid rectangle or square using the background color. This tool uses the tool palette’s fill style
settings.

To draw a solid rectangle:

Step 1. If the solid rectangle tool button (E) is not depressed, press the solid rectangle tool button on the Tool
Palette.
Step 2. Click the left mouse button at one corner of the desired rectangle.
Step 3. Move the mouse to the opposite point of the desired rectangle.
Step 4. Release the mouse button when done.

To draw a solid square:

Step 1. If the solid rectangle tool button ) is not depressed, press the solid rectangle tool
button on the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the square to equal with width.

Step 3. Click the left mouse button at one corner of the desired square.

Step 4. Move the mouse to the opposite point of the desired square.

Step 5. Release the mouse button when done.

To abort drawing a rectangle or square:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Hollow Ellipse Tool

The hollow ellipse tool draws a hollow ellipse or circle using the foreground color. This tool uses the tool palette’s line width and

ine style settings.

To draw a hollow ellipse:

Step 1. If the hollow ellipse tool button (g) is not depressed, press the hollow ellipse tool button on the Tool
Palette.
Step 2. Click the left mouse button at one corner of the desired ellipse.
Step 3. Move the mouse to the opposite point of the desired ellipse.
Step 4. Release the mouse button when done.

To draw a hollow circle:

Step 1. If the hollow ellipse tool button (|
on the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the circle to equal with width.
Step 3. Click the left mouse button at one corner of the desired circle.

Step 4. Move the mouse to the opposite point of the desired circle.

Step 5. Release the mouse button when done.

) is not depressed, press the hollow ellipse tool button

To abort drawing a ellipse or circle:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Filled Ellipse Tool
The filled ellipse tool draws an ellipse or circle using the foreground color for ellipse’s border and the background color for the
inside fill color. This tool uses the tool palette’s line width, line style and fill style settings.

To draw a filled ellipse:

Step 1. If the filled ellipse tool button (ﬂ) is not depressed, press the filled ellipse tool button on the Tool Palette.

Step 2. Click the left mouse button at one corner of the desired ellipse.
Step 3. Move the mouse to the opposite point of the desired ellipse.
Step 4. Release the mouse button when done.

To draw a filled circle:

Step 1. If the filled ellipse tool button (
the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the circle to equal with width.
Step 3. Click the left mouse button at one corner of the desired circle.

Step 4. Move the mouse to the opposite point of the desired circle.

Step 5. Release the mouse button when done.

) is not depressed, press the filled ellipse tool button on

To abort drawing a ellipse or circle:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Solid Ellipse Tool

The solid ellipse tool draws a solid ellipse or circle using the background color. This tool uses the tool palette’s fill style settings.
To draw a solid ellipse:

Step 1. If the solid ellipse tool button (ﬂ) is not depressed, press the solid ellipse tool button on the Tool Palette.

Step 2. Click the left mouse button at one corner of the desired ellipse.
Step 3. Move the mouse to the opposite point of the desired ellipse.
Step 4. Release the mouse button when done.

To draw a solid circle:

Step 1. If the solid ellipse tool button (|
the Tool Palette.

Step 2. Hold down the SHIFT key. This will cause the height of the circle to equal with width.
Step 3. Click the left mouse button at one corner of the desired circle.

Step 4. Move the mouse to the opposite point of the desired circle.

Step 5. Release the mouse button when done.

) is not depressed, press the solid ellipse tool button on

To abort drawing a ellipse or circle:
Step 1. While drawing, click the right mouse button.
-OR- Press the Escape (ESC) key.



Text Tool

The text tool draws text in the selected font.
To enter text:

Step 1. If the text tool button (ﬂ) is not depressed, press the text tool button on the Tool Palette.
Step 2. Click the left mouse button at one corner of the desired rectangular text area.
Step 3. Move the mouse to the opposite point of the rectangular text.
Step 4. Release the mouse button when done.
Step 5. Type the desired text. Use the backspace key to remove text. If the text does not appear exactly where desired, click
within the text rectangle and drag it to another location. The text's color can also be changed selecting a new foreground color from
the color bar.

Step 6. Press the ENTER key when done. At this point the text rectangle disappears and the text can no longer be

moved or colored.

To change the selected font:
Step 1. Select the Edit/Select Font menu item.

To abort drawing text:
Step 1. Press the Escape (ESC) key.

Changing the selected font affects the next time that the text tool is being used. Changing the selected font while the text tool is
being used will have no effect on the current text.



Line Width Setting

To select a line width, enter a value in the Wid. edit box on the Tool Palette or use its spin control to find the desired value.

Line width is measured in pixels. Valid line widths range between 1 and 15 pixel. The draw and line tools use this value to
determine the width of the line drawn. The arrow tool uses this value to determine the width of the line draw and the size of the

arrow head. The hollow rectangle, filled rectangle, hollow ellipse and filled ellipse tools use this value to determine the
thickness of their borders.

If a tool also has a line style setting, changing the line width to a value greater than 1 will cause the line style setting to change to
a solid line. For preview purposes, the solid line within the line style setting will grow in thickness as the line width setting
increases.



Line Style Setting

To select a line style, select the desired style from the Style combo box on the Tool Palette.

The line and arrow tools use this value to determine the style of the line drawn. The hollow rectangle, filled rectangle, hollow
ellipse and filled ellipse tools use this value to determine the style of their borders.

Changing the line style to a style other than a solid line will cause the line width setting to change to 1.



Fill Style Setting

To select a fill style, select the desired style from the Fill combo box on the Tool Palette.

The filled rectangle, solid rectangle, filled ellipse and solid ellipse tools use this value for their fill color. There are three types of
fill styles, solid, transparent hatch and two color hatch. Solid fill uses the background color and is the first item in the combo
box. Transparent hatch fills use the foreground color for the hatch pattern and are displayed in the combo box with a "T"

preceding them. Two color hatch fills use the foreground color for the hatch pattern and the background color for the
background.

For preview purposes, the foreground and background colors are used to display the fill styles. If nothing appears in the fill
combo box, try adjusting the foreground and background colors.



Color Bar

The color bar is used to select foreground and background colors for the currentimage. The color bar will appear and act in
one of four ways, depending on the color depth of the image. However, the four color bars do have several common features.

Foreground Color YWell
ﬁ Colar selection Area -
Background Colar Well
The foreground color well contains the foreground color used for drawing.

The background color well contains the background color used for drawing.
The color selection area is used to choose foreground and background colors.

To choose the foreground color:

Step 1. Click the left mouse button in the color selection area. The color at the cursor point will appear in the
foreground color well. The red, green and blue components of the selected color will appear in the
information area of the status bar.

Step 2. Move the mouse until the desired color appears in the foreground color well.
Step 3. Release the left mouse button.

To choose the background color:

Step 1. Click the right mouse button in the color selection area. The color at the cursor point will appear in the
background color well. The red, green and blue components of the selected color will appear in the
information area of the status bar.

Step 2. Move the mouse until the desired color appears in the background color well.
Step 3. Release the right mouse button.

Foreground and background colors can also be selected by using the pick color tool.

True Color Bar
Palette Color Bar

Grayscale Color Bar
Black and White Color Bar



True Color Bar

The color bar will appear as the true color bar for true color images. The number of colors to choose from will increase as the
Capture Professional main window is increased in width.
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This image has been reduced to 256 colors for this help file. If the true color bar is viewed with a 32K, 64K or 16.7M color video
driver, it will appear much better. The numbers will not appear in the actual true color bar.

The color selection area of the true color bar has 4 distinct areas.
Area 1: This area contains the 16 definable custom colors for the image. These colors default to the 16 standard
Windows colors. These colors can be redefined through the choose custom color dialog which is accessed
by double-clicking on the foreground or background color well.

Area 2: This area contains colors that contain mixtures of two of the three primary computer colors (red, green and
blue).
Area 3: This area contains colors that contain mixtures of all of the three primary computer colors (red, green, and

blue). This area is divided into 3 smaller areas. The first contains a blends of red and green with decreasing
red and increasing green from right to left and increasing blue from top to bottom. The second contains a
blends of green and blue with decreasing green and increasing blue from right to left and increasing red from
top to bottom. The last contains a blends of blue and red with decreasing blue and increasing red from right to
left and increasing green from top to bottom.

Area 4: This area contains grays ranging from black to white.

To choose a foreground color that does not appear in the selection area:

Step 1. Double-click with the left mouse button on the foreground color well. This will cause the choose custom color
dialog to appear.

To choose a background color that does not appear in the selection area:

Step 1. Double-click with the left mouse button on the background color well. This will cause the choose custom
color dialog to appear.



Palette Color Bar

The color bar will appear as the palette color bar for palette images. Palette images are contain possible 256 colors. These
colors appear in the palette color bar in a 32 x 8 grid.
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When using a palette color image, the 256 color can be redefined. If an existing color is redefined, all pixels within the image of the
existing color will change to the new color. For example, changing a color from gold to silver in the color palette will change all gold
pixels within the image to silver. The redefinition of a color can be undone as if it were a normal action.

To redefine a palette color:
Step 1: Move the cursor over the color to redefine.
Step 2: Double-click the left mouse button on the color to redefine. The Redefine Palette Color dialog will appear.



Grayscale Color Bar

The color bar will appear as the grayscale color bar for grayscale images. The functionality of the grayscale color bar does not
differ from the basic color bar. Grayscale images contain 256 shades of gray.

While it is possible to select all 256 grays from the grayscale color bar, viewing all 256 colors requires a 24-bit video driver.




Black and White Color Bar

The color bar will appear as the black and white color bar for grayscale images. The functionality of the grayscale color bar does
not differ from the basic color bar. Black and white images contain only black and white pixels.

ol




Toolbar

The toolbar provides quick, one click shortcuts to Capture Professional menu items.
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Click on areas of the above toolbar for more information.




Sharpen Menu Item

To begin sharpening an image, click on the Effects/Sharpen menu item or click on the Sharpen toolbar button (@l).



New Menu Item

Select the New menu item or the New toolbar button (ﬁl) to create a new, blank image with the Create New Image dialog.
This menu item is found on the File menu.




Extract Menu Item

Select the Extract menu item or the Extract toolbar button (Ll) to open a resource image from a 32-bit Windows executable
with the Extract dialog. This menu item is found on the FEile menu.




Adjust Color Effect

The adjust color effect is modifies the red, green and blue components of all pixels within current image or the selected area of
the current image.

This effect is available for true color images and palette color images. However, for palette images the effect is always applied
to the entire image.



Move this slider to the right to cause the image or its selected area to become redder. To cause the pixels to become more
cyan, move this slider to the left.



Move this slider to the right to cause the image or its selected area to become greener. To cause the pixels to become purpler,
move this slider to the left.



To cause the current image or its selected area to become redder enter a larger value in this edit box or press the up arrow. To
cause the current image or its selected area to become more cyan, enter a smaller value in this edit box or press the down
arrow.



To cause the current image or its selected area to become greener enter a larger value in this edit box or press the up arrow. To
cause the current image or its selected area to become purpler, enter a smaller value in this edit box or press the down arrow.



To cause the current image or its selected area to become bluer enter a larger value in this edit box or press the up arrow. To
cause the current image or its selected area to become more yellow, enter a smaller value in this edit box or press the down
arrow.



Threshold Blur Effect

The threshold blur effect softens the appearance of the current image or its selected area. The threshold and a pixel's
difference from its neighbors determines whether a pixel is blurred. Similar pixels will blur with low thresholds and higher .
Dissimilar pixels and edges will blur with a high threshold. Carefully choosing a threshold will allow smoothing without
degrading edges.

This effect is available for true color images, palette color and grayscale images.



To blur dissimilar pixels, move this slider to the right. To blur only similar pixels, move this slider to the left.



To blur dissimilar pixels, increase the value in the edit box or press the up arrow. To blur only similar pixels, decrease the value
in the edit box or press the down arrow.



Gaussian Blur Effect

The gaussian blur effect gives the current image or its selected area a hazy, slightly out of focus appearance. This effect can
improve the quality of images with sharp images.

This effect is available for true color images, palette color and grayscale images.



Change Brightness Effect

The change brightness effect brightens or darkens the current image or its selected area. This effect adds the adjustment to the
red, green and blue components of each pixel.

This effect is available for true color images, palette color and grayscale images.



Move this slider to the right to brighten the current image or its selected area. To darken the current image or its selected area,
move this slider to the left.



To brighten the current image or its selected area, increase the value in the edit box or press the up arrow. To darken the
current image or its selected area, decrease the value in the edit box or press the down arrow.



Gamma Brighten Effect

The gamma brighten effects brightens or darkens the current image or its selected area by adjusting the gamma curve of the
image. For simplicity the gamma values have been proportionately adjusted to range from -100 to 100.  Values greater than
zero brighten the image. Values less than zero darken the image.

This effect is available for true color images, palette color and grayscale images.



Move this slider to the right to brighten the current image or its selected area. To darken the current image or its selected area,
move this slider to the left.



To brighten the current image or its selected area, increase the value in the edit box or press the up arrow. To darken the
current image or its selected area, decrease the value in the edit box or press the down arrow.



Histobrighten Effect

The histobrighten effect brightens the current image or its selected area by reassigning brightness levels so that contrast is
improved. Histobrightening an image generally reduces the number of colors, which may result in a loss in detail. This effect is
useful to bring our details partially hidden in shadows.

This effect is available for true color images, palette color and grayscale images.



Limit Brightness Effect

The limit brightness effects sets the maximum brightness level within the image.  Pixels brighter than the selected value are set
to the selected maximum brightness. This effect will darken an image without losing darker details.

This effect is available for true color images, palette color and grayscale images. The speed of this effect is very slow unless
the image is grayscale or is small in size.



To darken the image by decreasing the maximum brightness, move this slider to the left. To restore brightness levels, move this
slider to the right.



To darken the image by decreasing the maximum brightness, enter a smaller number in this edit box or press the down arrow.
To restore brightness levels, enter a larger number in this edit box or press the up arrow.



Midrange Brighten Effect

The midrange brighten effect brightens the intermediate brightness levels within the current image or its selected area.
This effect is available for true color images, palette color and grayscale images.



Contrast Effect

The contrast effect increases the contrast of the current image or its selected area by expanding the brightness range. This
effect takes two parameters. The first parameter's value sets the amount of contrast. The second value sets the brightness
bias.

This effect is available for true color images, palette color and grayscale images.



Move this slider to the right to increase the contrast of the current image or its selected area. To increase, contrast of the
current image or its selected area less, move this slider to the left.



To increase contrast of the current image or its selected area, enter a larger value in this edit box or press the up arrow. To
increase contrast of the current image or its selected area less, enter a smaller value in this edit box or press the down arrow.



Move this slider to the right to increase the brightness of the current image or its selected area. To decrease the brightness of
the current image or its selected area, move this slider to the left.



To increase the brightness of the current image or its selected area, enter a larger value in this edit box or press the up arrow.
To decrease the brightness of the current image or its selected area, enter a smaller value in this edit box or press the down
arrow.



Equalize Effect

The equalize effect reassigns brightness levels of the current image or its selected area so that each brightness level is more
evenly represented. This effect is best applied to dark images.

This effect is available for true color images, palette color and grayscale images.



Flip Horizontally Operation

The flip horizontally operation flips the current image or its selected area left to right.

This operation is available for images of all color depths.



Flip Vertically Operation

The flip vertically operation flips the current image or its selected area top to bottom.

This operation is available for images of all color depths.



Crop Operation

The crop operation reduces the image size to the selected area of the current image.

This operation is available for images of all color depths.



Convert To True Color Operation

This operation changes the image's color depth to 24 bits.

This operation is available for color, grayscale and black & white images.



Convert To Color Operation

This operation changes the image's color depth to 8 bits. This will create a color palette of 256 user-definable colors. This
dialog will only appear for true color images.

This operation is available for true color, grayscale and black & white images.



Convert To Grayscale Operation

The convert to grayscale operation changes the image's color depth to 8 bits.  This will create a color palette composed of 256
unchangeable shades of gray.

This operation is available for true color, color and black & white images.



Move this slider to the right for better quality. For faster conversion speed, move this slider to the left.



Move this slider to the right to dither the image. To use solid colors, move this slider to the left.



Move this slider to the right to increase the number of colors used. To decrease the number of colors used, move this slider to
the left.



To increase the number of colors used, enter a larger number in the edit box or press the up arrow. To decrease the number of
colors used, enter a smaller number in the edit box or press the down arrow.



Convert To Black & White Operation

The convert to black & white operation changes the image's color depth to 1 bit.

This operation is available for true color, color and grayscale images.



Increase Size Operation

The increase size operation adds pixels to a specified size of the current image using the Increase Image Size dialog.

This operation is available for all images.



Remove Transparent Layer Operation

The remove transparent operations removes the transparent layer from an icon or cursor that has been extracted from an
executable and replaces the transparent colors with the currently chosen background color.



Rotate 90° Clockwise Operation

The rotate 90° clockwise operation rotates the current image 90° to the right.
height and the image's height to become its width.

This causes the image's width to become its

This operation is available for true color, color and grayscale images.



Rotate 90° Counter-Clockwise Operation

The rotate 90° counter-clockwise operation rotates the current image 90° to the left. This causes the image's width to become
its height and the image's height to become its width.

This operation is available for true color, color and grayscale images.



Rotate Any Angle Operation

The rotate any angle operation rotates the current image in one degree increments. The image's width and height will change
accordingly. New image areas exposed by this operation are filled with the background color.

This operation is available for true color, color and grayscale images.



Move this slifer to the right of the middle tick mark to rotate the current image clockwise. To rotate the current image counter-
clockwise, move this slider to the left of the middle tick mark.



To rotate the current image clockwise, enter a positive value in this edit box or press the up arrow. To rotate the current image
counter-clockwise, enter a negative value in this edit box or press the down arrow.



Scale Operation

The scale operation increases or decreases the current image's size, maintaining the current width to height ratio. The current
image is sized to fit completely within the new size.



Stretch Operation

The scale operation increases or decreases the current image's size. Height and width are stretched independently. The
current image is sized to fit completely within the new size.



Move this slider to the right to increase the current image's size. To decrease the current image's size, move this slider to the
left.



To increase the image's size, enter a larger value in this edit box or click the up arrow. To decrease the image's size, enter a
smaller value in this edit box or click the down arrow.



Move this slider to the right to increase the current image's width. To decrease the current image's width, move this slider to the
left.



Move this slider to the right to increase the current image's height. To decrease the current image's height, move this slider to
the left.



To increase the image's width, enter a larger value in this edit box or click the up arrow. To decrease the image's width, enter a
smaller value in this edit box or click the down arrow.



To increase the image's height, enter a larger value in this edit box or click the up arrow. To decrease the image's height, enter
a smaller value in this edit box or click the down arrow.



Invert Effect

The invert effect applies a photo-negative effect to the current image or its selected area.



Black & White Effect

The Black & white effect converts the current image or its selected area to black and white using the scatter technique. The
image's color depth is not changed by this effect.



To increase the threshold, move this slider to the right. To decrease the threshold, move this slider to the left. Colors above the
brightness threshold in brightness are changed to white. Colors beneath the brightness threshold are changed to black.



To increase the threshold, enter a larger value in this edit box or click the up arrow. To decrease the threshold, enter a smaller
value in this edit box or click the down arrow. Colors above the brightness threshold in brightness are changed to white.
Colors beneath the brightness threshold are changed to black.



Outline Effect

The outline effect highlights edges within the current image or its selected area.



Pixelize Effect

The pixelize effect averages neighboring pixels into user-define square areas.



To increase the pixelization size, move this slider to the right. To decrease the pixelization size, move this slider to the left.



To increase the pixelization size, enter a large value in this edit box or press the up arrow. To decrease the pixelization size,
enter a smaller value in this edit box or press the down arrow.



Posterize Effect

The posterize effect reduces the number of colors that exist within an image.



To increase the number of colors, move this slider to the right. To decrease the number of colors move this slider to the left.



To increase the number of colors, enter a larger value in this edit box or press the up arrow. To decrease the number of colors,
enter a smaller value in this edit box or click the down arrow.



Remove Noise Effect

The remove noise effect removes random noise from the current image or its selected area. This effect replaces each pixel with
the median value of the pixel and all of its immediate neighbors.



Sharpen Effect

The sharpen effect increases the differences between neighboring pixels of the current image or its selected area. This effect
makes details more visible, but it can introduce unwanted noise.



To sharpen the current image or it selected area more dramatically, move this slider to the right. To sharpen this image or its
selected area more gently, move this slider to the left.



Editing An Image
The current image can be manipulated in three ways:
Drawing Tools These tools include many common painting tools.

Operations Operations change the image size, color depth or orientation.
Effects Effects alter the current image's or its selected area's brightness, color and relationships between neighboring

pixel.



Drawing Tools

Capture Professional offers the following drawing tools:
Arrow Tool

Draw Tool

Fill Tool

Filled Ellipse Tool

Filled Rectangle

Line Tool

Hollow Ellipse Tool

Hollow Rectangle Tool
Pick Color Tool

Selection Tool
Solid Ellipse Tool

Solid Rectangle Tool
Text Tool

Some of these tools use the following settings that are found on the tool palette.

Eill Style Setting
Line Style Setting
Line Width Setting



Operations

Capture Professional offers the following operations to change the image size, color depth or orientation.
Color Replace Operation

Convert To Black & White Operation
Convert To Color Operation

Convert To Grayscale Operation

Convert To True Color Operation

Crop Operation

Custom Palette Operation

Flip Horizontally Operation

Elip Vertically Operation

Increase Size Operation

Remove Transparent Layer Operation
Rotate Any Angle Operation

Rotate 90° Clockwise Operation

Rotate 90° Counter-Clockwise Operation
Scale Operation

Stretch Operation

Use Netscape Palette Operation

Use Standard Rainbow Palette Operation



Effects

Capture Professional offers the following effects to alter the current image's or its selected area's brightness, color and
relationships between neighboring pixel.

Adjust Color Effect
Black & White Effect

Change Brightness Effect
Contrast Effect

Edge Emphasis Effect
Equalize Effect

Fade Edges Effect
Gaussian Blur Effect
Gamma Brighten Effect
Histobrighten Effect
Invert Effect

Limit Brightness Effect

Midrange Brighten Effect
Outline Effect

Pixelize Effect

Posterize Effect

Remove Noise Effect
Reverse Threshold Blur Effect
Sharpen Effect

Threshold Blur Effect

Wash Out Effect



To cause the image or its selected area to become more blue, move this slider to the right. To cause the pixels to become more
yellow, move this slider to the left.



File Menu

The File menu is located on the menu bar and contains the following menu items:
Close

Exit

Extract

Preferences



Edit Menu

The Edit menu is located on the menu bar and contains the following menu items:
Copy

Copy To Application

Find Application

Mix Colors

Paste As New Image
Paste Into Current Image
Properties

Purge Undo

Redo

Select All

Select Font

Swap Colors

Undo

Undo/Redo Actions




View Menu

The View menu is located on the menu bar and contains the following menu items:
Color Bar
Status Bar
Tool Palette
Toolbar
Zoom 25%
Zoom 50%
Zoom 100%
Zoom 200%
Zoom 400%
Zoom 800%



Capture Menu

The Capture menu is located on the menu bar and contains the following menu items:
Active Client Area

Active Window

Client Area

Control

Desktop

Icon

enu

Menu Capture Wizard menu item
Oval

Polygon

Rectangle

Window

<




Operations Menu

The Operations menu is located on the menu bar and contains the following menu items:
Color Palette Menu

Color Replace Menu Item

Convert To menu

Crop

Elip menu

Increase Size

Remove Transparent Layer
Rotate menu



Convert To Menu

The Convert To menu is located on the Operations menu and contains the following menu items:
Black and White

Grayscale

Palette Color

True Color



Flip Menu
The Flip menu is located on the Operations menu and contains the following menu items:

Horizontal
Vertical



Rotate Menu
The Rotate menu is located on the Operations menu and contains the following menu items:

Any Angle
90° Clockwise

90° Counter-Clockwise



Effects Menu

The Effects menu is located on the menu bar and contains the following menu items:
Adjust Color

Black & White

Blur menu
Brightness menu
Contrast

Edge Emphasis
Equalize

Fade Edges

Invert

Outline

Painting Styles menu
Pixelize

Posterize

Remove Noise

Sharpen
Wash Out



Brightness Menu

The Brightness menu is located on the_Effects menu and contains the following menu items:
Change

Gamma Brighten

Histobrighten

Limit

Midrange Brighten



Blur Menu
The Blur menu is located on the_Effects menu and contains the following menu items:

Gaussian
Reverse Threshold
Threshold



Window Menu

The Window menu is located on the menu bar and contains the following menu items:
Arrange Icons

Close All

Cascade

List of Image Windows

Tile Horizontal

Tile Vertical

Minimize All



Help Menu
The Help menu is located on the menu bar and contains the following menu items:

About Capture Professional
Enter Serial Number

Help Topics



Menu Bar

The menu bar contains the following sub-menus:
File menu

Edit menu

View menu

Capture menu

Operations menu
Effects menu

Macro Menu
Window menu
Help menu



Close Menu Item

Select the Close menu item to close the current image window. The Close menu items is located on the File menu.

If the image has been modified or is new and has not been saved, a prompt will appear to save the image before it is closed.



Mix Colors Menu Item

Select the Mix Colors menu item to blend the foreground color with the background color. The foreground and background
colors will become the new blended color after this menu item is selected. This menu item is located on the Edit menu and is

only available for true color images.



Swap Colors Menu Item

Select the Swap Colors menu item to exchange the foreground color with the background color. This menu item is located on
the Edit menu.



Properties Menu Item

Select the Properties menu item to display the current image's image and file properties in the Properties dialog.



Properties Dialog

The Properties dialog contains image and file pages for the current image. The File property page only exists for images that
have file names. Select the Edit/Properties menu item to cause this dialog to appear.



Redo Menu Item

Select the Redo menu item to reapply the last undone action. This menu item is located on the Edit menu and is disabled if
there is not an action to reapply. After this menu item is selected, it may take several seconds to recalculate the current image.




Select Font Menu Item

Select the Select Font menu item to display the Choose Font dialog.



Undo/Redo Actions Menu Item
Select the Undo/Redo Actions menu item to display the Undo/Redo Actions dialog.



Color Bar Menu Item

Select the Color Bar menu item to toggle the display of the color bar when image windows exist. This menu item is located on
the View menu.



Status Bar Menu ltem

Select the Status Bar menu item to toggle the display of the status bar. This menu item is located on the View menu.



Tool Palette Menu ltem

Select the Tool Palette menu item to toggle the display of the tool palette. This menu item is located on the View menu.



Toolbar Menu Item

Select the Tool Palette menu item to toggle the display of the toolbar. This menu item is located on the View menu.



Active Client Area Menu ltem

Select the Active Client Area menu item to capture the active client area. This menu item is located on the Capture menu.



Active Window Menu Item

Select the Active Client Area menu item to capture the active window. This menu item is located on the Capture menu.



Client Area Menu Item

Select the Client Area menu item or the Client Area toolbar button (|
This menu item is located on the Capture menu.

) to begin capturing a client area.



Desktop Menu Item

Select the Desktop menu item or click the Capture Desktop toolbar button (|
screen. This menu item is located on the Capture menu.

) to capture the entire



Icon Menu Item

Select the Icon menu item to begin capturing an icon. This menu item is located on the Capture menu.



Oval Menu Item
Select the Oval menu item to begin capturing an ellipse. This menu item is located on the Capture menu.



Polygon Menu Item
Select the Polygon menu item to begin capturing a polygon. This menu item is located on the Capture menu.



Rectangle Menu Item

Select the Rectangle menu item or click the Capture Rectangle toolbar button (
rectangle. This menu item is located on the Capture menu.

) to begin capturing a



Window Menu ltem

Select the Active Client Area menu item or click the Capture Window toolbar button (
awindow. This menu item is located on the Capture menu.

) to begin capturing



Increase Size Menu ltem

Select the Increase Size menu item to begin increasing the size of the current image. This menu item is located on the
Operations menu.



Remove Transparent Layer Menu Iltem

Select the Remove Transparent Layer menu item to remove the transparent layer from extracted icon and cursor images. This
menu item is located on the Operations menu.



Scale Menu Item
Select the Scale menu item to begin scaling the current image. This menu item is located on the Operations menu.



Stretch Menu Item
Select the Stretch menu item to begin stretching the current image. This menu item is located on the Operations menu.



Adjust Color Menu Item
Select the Adjust Color menu item to begin adjusting the current image's color. This menu item is located on the Effects menu.



Black and White Menu ltem

Select the Black and White menu item to begin transforming the current image to black and white. This menu item is located on
the Effects menu.



Edge Emphasis Menu Item

Select the Edge Emphasis menu item to begin emphasizing edges within the current image. This menu item is located on the
Effects menu.



Edge Emphasis Effect

The edge emphasis effect enhances directional lines within an image using the Edge Emphasis dialog.



Preferences Dialog

The Preferences dialog contains four pages for configuring Capture Professional:

Capture Options This page configures options related to capturing images.

Hotkey Setup This page configures hotkeys used for capturing images.

General/Timer This page configures general program options and timer options.

Direct Capture This page configures capturing directly to file, printer, clipboard or application.

Select the File/Preferences menu item to cause the Preferences dialog to appear.



Gamma Brighten Menu Item

Select the Gamma Brighten menu item to begin adjusting the gamma of the current image. This menu item is located on the
Effects/Brightness menu.



Histobrighten Menu Item

Select the Histrobrighten menu item to histobrighten the current image. This menu item is located on the Effects/Brightness
menu.




Gaussian Menu Item

Select the Gaussian menu item to apply a hazy, slightly out of focus appearance to the current image. This menu item is found
on the Effects/Blur menu.




About Capture Professional Menu Item

Select the About Capture Professional menu item to display version, copyright and registration information in the About dialog.



Reverse Threshold Blur Effect

The threshold blur effect softens the appearance of the current image or its selected area. The threshold and a pixel's
difference from its neighbors determines whether a pixel is blurred. Dissimilar pixels will blur with low thresholds and higher.
Simimilar pixels and edges will blur with a high threshold. Carefully choosing a threshold will allow sharp edges to be blurred

with the background. This effect is the opposite of the threshold blur effect.

This effect is available for true color images, palette color and grayscale images.



Move this slider to the right to blur more pixels. To blur less pixels, move this slider to the left.



To blur more pixels, increase the value in the edit box or press the up arrow. To blur less pixels, decrease the value in the edit
box or press the down arrow.



Reverse Threshold Menu Item

Select the Reverse Threshold menu item to begin reverse blurring the current image or its selected area. This menu item is
located on the Effects/Blur menu.



Revision History

Capture Professional 3.11a

The client area mode cursor changes when using the client area scroll option and the client area is scrollable.
Using the right mouse button when capturing a rectangle or oval no longer stops at window boundaries.
Fixed bug in newly streamlined undo logic introduced in Capture Professional 3.11.

Capture Professional 3.11
Added the abiltiy to automatically scroll the client area, if the client area has an enabled vertical scroll bar.

Added tool tips to tool palette. Tool tips can be long on short based on the Long tool tips setting on the General/Timer page of
the Preferences dialog.

Undo/Redo logic has been streamlined and undo, redo and undo/redo buttons have been added to the button bar.

Capture Professional 3.10

Added the ability to move and copy potions of an image by selecting and draging it .

Added the ability to paste a clipboard image into the current image .
Enhanced the Hotkey Setup page of the Preferences dialog to allow more flexible configuration of hotkeys. The control, shift
and alt keys can be set for each capture mode. Additionally, several other keys have been added as possible hotkeys.

Desktop mode can now capture images in full screen DirectX games .
A new capture “mode”, Repeat Last Capture, has been added — complete with its own configurable hotkey. This mode will
automatically capture the last window or area that was captured.

A new effect, Wash Out, has been added. This effect blends the current image or its selected area with the background color
and is useful for creating watermark images.

A new effect, Fade Edges, has been added. This effect fades the outside of the current image (to the selected background
color) to help indicate that the image is part of a larger image. Any or all edges can be specified.

Drawing tools now indicate their position and size in pixels on the status bar.

Include Owned Popup Windows option has a new suboption to allow parent windows to be included when the popup is selected.
General user interface enhancements have been made to many dialogs.

Deleted macros no longer appear in Capture Mode page or Print dialog to be auomatically applied.

The JPEG Preview option and the Direct Save option are now compatible.

Capture Professional 3.09

Added macro capabilities.

Added option to Include Owned Popup Windows for Window and Active Window modes.
Added timer options to allow up to 25 images to be captured using the timer.

Fixed GPF in Edge Emphasis effect on Windows NT 4.0.

Fixed GPF in Menu Capture Wizard on Windows NT 4.0.

Fixed positioning of included cursor for Menu Capture Wizard.

Capture Professional 3.08

Added Use Windows Palette Operation
Added Color Replace Operation

Fixed problem with saving PCX files.

Capture Professional 3.07

Added ability to preview JPEG compression before file is saved.

Enhanced ability to view 16.7 million color images on a 256 color video driver.

Added Use Netscape Palette operation.

Added Use Rainbow Palette operation.

Added Save Palette operation.

Added Load Palette operation.

Images captured on a 256 color video driver no longer have the grayscale button inititally depressed.
Fixed a memory corruption problem.

Fixed oval mode inverting the wrong area of the screen (problem introduced in v3.05).
Fixed spelling of "promted".

Capture Professional 3.06



Added GIF file format to save or open images.
Added ability to disable sounds
Capture Professional will restore after capture when previously minimized.

Capture Professional 3.05

Added Menu capture mode and associated hotkey functionality.

Added Control capture mode and associated hotkey functionality.

Removed Find Controls option from Capture Mode page of Preferences dialog (no longer needed).
Horizontal and vertical file resolution settings are now saved between Capture Professional sessions.
Hotkeys now work from within a DOS window.

Miscellaneous enhancements to capture logic.

Capture Professional 3.04

Improved positioning of images that viewed on startup.

Rotate Clockwise operation no longer rotates counter-clockwise.
Rotate Any operation successfully rotates images +90° and +180°.
Added Menu Capture Wizard to easily capture multiple menus.

Capture Professional 3.03
Fixed problem with the Capture Professional Help file not being found.

Capture Professional 3.02

Added ability to open and save PNG files.

Fixed problem with timer capture not allowing window being captured to respond

Added Watercolor Painting effect

Added Pointillistic Painting effect

Enhanced Posterize effect

Enhanced timer capture — always shows capture cursor during image capture, even if capture cursor option is selected.

Capture Professional 3.01

Fixed Active Window mode capturing problem.

Fixed Active Client Area mode capturing problem.

Fixed Minimize on Startup option.

Fixed Help and Order Form buttons generating "Out of Memory" error in demo version.



Painting Styles Menu
The Painting Styles menu is located on the Effects menu and contains the following menu items:

Pointillistic
Watercolor



Watercolor Menu ltem

Select the Watercolor menu item to apply the watercolor painting style to the current image. This menu item is located on the
Effects/Painting Styles menu.



Pointillistic Menu ltem

Select the Pointillistic menu item to apply the pointillistic painting style to the current image. This menu item is located on the
Effects/Painting Styles menu.



Pointillistic Effect

The pointillistic effect makes an image appear as if it was painted in the style of Seurat with lots of little dots and dabs of paint.



Watercolor Effect

The watercolor effect is smooths out irregularities in the image and accentuates the color boundaries. This process will cause
the current image or its selected area to appear as if it were painted using watercolor paints.



Select the application to capture menus from. An application must have a real menu and be running to appear in the list.
Some applications, like those found in Microsoft Office 97, do not have real menus. If the desired application is not running,
start the application and then press the Refresh List button.



Press the refresh list button to update the list of applications in the Application list box to display all currently running applications
with a real menu.



Select the menu to start capturing from. If the Capture all menus beneath the selected menu check box is checked, enabled
menus beneath the selected menu will also be captured.



Select this check box to capture menu's beneath the menu selected in the above tree control.

For Example:

If the Menu Bar is selected and the application selected in the previous page has File and Help menus and the File menu has a
New menu, the following menus will be captured in the following order:

The main menu bar
The File menu

The New menu
The Help menu



Select this radio button to capture one image per menu captured. The first enabled menu item will be displayed as selected.



Select this menu item to capture multiple images for each menu captured. The menu will be captured once for every enabled
menu item within the menu. Each capture will have a different menu item selected. This option may require large quantities of
memory.



Select this menu item to capture each menu so that new image only contains the top most menu. This option creates smaller
images than selecting the Composite menu radio button.



Select this menu item to capture each menu so that new image contains overlapped menus and includes a portion of the menu
bar. This option creates larger images than selecting the Single menu radio button.

For example:
An application has a File menu. This File menu has a New menu. When captured, the New menu will be captured on top of
the File menu and portion of the menu bar.



Menu Capture Wizard

The Menu Capture Wizard allows multiple menus to be captured easily and effortlessly. The Menu Capture Wizard contains
three pages. An application must be running and have real menus to use the Menu Capture Wizard. Microsoft Office 97
applications and other Microsoft applications with “tear-off* menus do not have real menus.

Page 1:
The first page specifies which application to capture menus from.
This page contains:
A list box containing a list of applications with real menus
A "Refresh List" button

Page 2:
The second page specifies the menu to capture from the application chosen on the first page.
This page contains:
A tree control containing menus
A "Capture all menus beneath the selected menu" check box

Page 3:
The last page specifies options for capturing the menus specified in the second page.
This page contains:

A "Only the first enabled menu item for each menu" radio button

An "Every enabled menu for each menu" radio button

A "Single menu" radio button

A "Composite menu" radio button




Menu Capture Wizard Menu Item
Select the Menu Capture Wizard menu item to display the Menu Capture Wizard.



How to Capture a Control

Step 1.

-OR-

Step 2.
Step 3.

Step 4.

Select the Capture/Control.

Use the control hotkey sequence. The default hotkey sequence for window capture is CTRL + SHIFT + ‘N’.
To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'N' key and
release all three keys. This hotkey can be changed on the Hotkey Setup page.

+
The cursor will turn into the control capture cursor ( ). If the cursor is over a control, or certain child
windows, that the control will be inverted.
Move the cursor over the desired control. As the cursor moves from one control to the next, the previously
selected control will be restored to its original condition and the new control will be inverted.
Click the left mouse button to complete the capture. The control will be captured immediately or optionally
after the duration of the timer.

Capturing a control can be aborted at any time by pressing the escape key.



How to Capture a Menu

Step 1. Display the desired menu.

Step 2. Use the menu hotkey sequence. The default hotkey sequence for window capture is CTRL + SHIFT + ‘M’.
To use this sequence, press and hold the Control key, press and hold the Shift key, press the 'MN' key and
release all three keys. This hotkey can be changed on the Hotkey Setup page.

Step 3. The menu will be captured immediately or optionally after the duration of the timer.

The Menu Capture Wizard is recommended for capturing multiple menus.



Menu Menu ltem

Select the Menu menu item to capture a menu on the screen. This menu item is located on the Capture menu.



Control Menu Item

Select the Control menu item to begin capturing a control. This menu item is located on the Capture menu.



Select the hotkey to capture a menu from the Menu combo box.



Select the hotkey to capture begin capturing a control from the Control combo box.



Select the Enable Sound check box to enable sounds within Capture Professional. Specifically, two sounds exist:

SOUND #1: A ticking sound when using the timer to after selecting an area of the screen to capture, but before the actual
capture takes place.

SOUND #2: A camera sound (with charging flash) after each image is captured.



JPEG Preview Dialog

The JPEG preview dialog appears after a JPEG image is saved in the Save dialog and [Preview Before Saving] is selected in the
Compression combo box. This dialog box is used to increase or decrease the image quality of the saved file.

Higher quality images require more space, lower quality images require less space. This dialog easily illustrates these tradeoffs
by displaying the saved images and the file size using the selected compression. Increasing the value in the edit box increase
the saved file's size and image quality. The value in the edit box can be manipulated by entering a value in the edit box, using
the spin buttons next to the edit box or by dragging the slider left to right.

Due to the complexity of this process, large images may require several seconds to display the new image.



Load Palette Dialog

The Load Palette dialog selects a palette for use with the Custom Palette operation. It is a standard File Open dialog box that
allows you to open Capture Professional's .PAL file format.



Save Palette Dialog

The Save Palette dialog is saves the palette of an 8-bit color image. After being saved, this palette can be applied to other
images using the Custom Palette operation.



Use Netscape Palette Menu Item
Select the Use Netscape Palette menu item to map the current palette color image to Netscape's standard 216 colors.

This menu item is found on the Operations/Color Palette Menu.



Use Standard Rainbow Palette Menu Item

Select the Use Standard Rainbow Palette menu item to map the current palette color image to Capture Professional's standard
rainbow palette.

This menu item is found on the Operations/Color Palette Menu.



Load Palette Menu Item
Select the Load Palette menu item to map the current palette color image to a previously saved palette.

This menu item is found on the Operations/Color Palette Menu.



Save Palette Menu Item

Select the Save Palette menu item to save the current image's palette. This palette can then be used by other image after the
Custom Palette operation is used.

This menu item is found on the Operations/Color Palette Menu.



Color Palette Menu

The Operations menu is located on the Operations menu and contains the following menu items:
Load Palette Menu Item

Save Palette Menu Item

Use Netscape Palette Menu Item

Use Standard Rainbow Palette Menu Item

Use Windows Palette Menu Item



Use Netscape Palette Operation

The Use Netscape Palette operation changes the current color palette to the 216 standard colors that Netscape products use to
render images.

This operation is only available for true color and palette color images.

To use this operation:

Step 1. Select the Operations/Color Palette/Use Netscape Palette menu item. A dialog box will appear.
Step 2. Choose either the Optimized or Normal method for color selection.
Step 3. Optionally choose to dither the image to the new palette. Choose "Dithered" for photographic images.

Choose "None" for screen captures.
Step 4. Press OK.



Use Standard Rainbow Palette Operation

The Use Standard Rainbow Palette operation changes the current color palette to a 256 color palette that contains 20 standard
Windows colors, 20 shades of gray and 216 rainbow colors

This operation is only available for true color and palette color images.

To use this operation:

Step 1. Select the Operations/Color Palette/Use Standard Rainbow Palette Menu Item. A dialog box will appear.
Step 2. Choose either the Optimized or Normal method for color selection.
Step 3. Optionally choose to dither the image to the new palette. Choose "Dithered" for photographic images.

Choose "None" for screen captures.
Step 4. Press OK.



Custom Palette Operation

The Custom Palette operation changes the current color palette to the a previously saved palette. All existing colors are then
mapped to the new palette.

This operation is only available for true color and palette color images.

To use this operation:

Step 1.
Step 2.
Step 3.
Step 4.
Step 5.

Step 4.

Select the Operations/Color Palette/Load Palette Menu Item.
Select the desired palette in the_Load Palette dialog box.

Press OK. A dialog box will appear.

Choose either the Optimized or Normal method for color selection.

Optionally choose to dither the image to the new palette. Choose "Dithered" for photographic images.
Choose "None" for screen captures.

Press OK.



To increase the file quality of the JPEG image, enter a larger value or press the up arrow. To reduce the file size of the JPEG
image, enter a smaller value or press the down arrow.



To increase the file quality of the JPEG image, move the slider to the left. To reduce the file size of the JPEG image, move the
slider to the right.



Use Windows Palette Operation

The Use Windows Palette operation changes the current color palette to the 16 standard or 20 extended default Windows colors.
There are 16 standard windows colors for the standard 16-color VGA video driver. There are 20 standard window colors for
drivers displaying 256 colors or more.

This operation is only available for true color and palette color images.

To use this operation:

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.

Select the Operations/Color Palette/Use Netscape Palette menu item. A dialog box will appear.
Choose either the Optimized or Normal method for color selection.

Optionally choose to dither the image to the new palette. Choose "Dithered" for photographic images.
Choose "None" for screen captures.

Choose to use the 16 standard or 20 extended colors using the Number of Colors slider.
Press OK.



Color Replace Operation

The Color Replace operation replaces the currently selected foreground color with the currently selected background color in the
current image or its selected area.

For true color and palette color images this operation has a Threshold parameter. This Threshold parameter determines how
closely a pixel must match the foreground color to be replaced with the background color.

This operations has an additional Replace parameter for true color images. Absolute replacement changes pixels within the
threshold of the foreground color to the background color only. Relative replacement changes pixels within the threshold of the
foreground color to a color similar to the background color. When relative replacement is used, replaced colors that are slightly
brighter than the foreground color will be a slightly brighter variation of the background color.  Relative replacement only differs
from absolute replacement when thresholds of one or greater are used.

To use this operation:

Step 1. Choose the color to be replaced, by changing the foreground color to that color. The Pick Color tool is very
useful for this.

Step 2. Choose the color to replace the background color by changing the background color to that color. This can
be accomplished by using the Pick Color tool or right clicking on the desired color in the Color Bar.

Step 3. Select the Operations/Color Replace.... menu item. A dialog box will appear.

Step 4. Choose the threshold used to determine whether a pixel matches the foreground color by adjusting the
Threshold slider.

Step 5. For true color images only, select whether to absolutely or relatively replace the foreground color with the

background color.
Step 6. Press OK.



Use Windows Palette Menu Item
Select the Use Windows Palette menu item to map the current palette color image to Windows standard colors.

This menu item is found on the Operations/Color Palette Menu.



Color Replace Menu Iltem

Select the Color Replace menu item to replace occurrences of the foreground color and similar colors with the background color
or color similar to the background color.

This menu item is found on the Operations.



The Threshold slider specifies how closely a pixel in the current image has to match the foreground color to be changed to the
background color. For a closer match, move the Threshold slider to the left. To match a broader range of colors, move the
Threshold slider to the right.



The Threshold edit specifies how closely a pixel in the current image has to match the foreground color to be changed to the
background color. For a closer match, enter a smaller number in the Threshold edit box or press the down arrow next to the
Threshold edit box. For a broader match, enter a larger number in the Threshold edit box or press the up arrow next to the
Threshold edit box.



Move the slider to the left to replace a color only with the background color. Move the slider to the right to maintain the

difference between closely related shades.

This option will cause a difference in image appearance when the Threshold value is 1 or greater. This option is not available

for palette color images.



Move the slider to the left to use the 16 default Windows colors used by a 16 color video driver. Move the slider to the right to
use the 20 default Windows colors used by 256 color and higher video drivers.

Choose the 16 color option if you plan to save the image as a 4-bit image.



Macros

Macros enable the user to record effects and operations applied to an image. This allows the same sequence of effects and
operations to be quickly applied to other images. Macros can be manually applied to an image or automatically applied to an
image after capture or before printing.

For single user licenses, the macro definition file (MACRO.CPM) is placed in the same directory as the CAPPRO32.EXE file.
For multiple user licenses, the location and/or name of the macro definition can be changed to a user chosen directory and/or
file. Only one user can open a macro definition file at a time.

See Also:

How to record a macro

How to apply a macro

How to delete a macro

How to automatically apply a macro after capture
How to automatically apply a macro before printing



How to record a macro

Macros are added to Capture Professional by recording effects and operations that are applied to the current image.

Step 1.
Step 2.
Step 3.

Step 4.
Step 5.

NOTE:

Open, capture, extract or create an image.
Select the Macro/Start Recording menu item.

Apply one or more effects or operations to the image. Drawing tools or macros that are applied will be
ignored by the recording process and cannot be included in a macro.

Select the Macro/Stop Recording menu item.

The Save Macro dialog will appear. Enter the name of the macro in the edit box and press the Save button.
The macro name cannot be the same as an already existing macro.

Recording a macro can be aborted by selecting another image while recording or by selecting the Macro/Stop
Recording... menu item and then pressing the Abort button on the Save Macro dialog.



How to apply a macro

Once a macro has been recorded, it can then be used to apply the same sequence of operations and effects to another image.
Once a macro is applied it can be undone and redone like any other effect, operation or drawing tool.

Step 1. Click on the desired image window to select it as the current image window.
Step 2. Select the Macro/Apply menu item.
Step 3. The Select Macro dialog will appear. Select the desired macro name and press the OK button. Optionally

you can double click on the desired macro name.



How to delete a macro

When a macro is no longer needed, it can be deleted. Once a macro is delete it cannot be recovered.

Step 1.
Step 2.
Step 3.
Step 4.

Select the Macro/Edit menu item.

The Edit Macro dialog will appear. Select one or more macros that you wish to delete from the list box.

Press the Delete button.

A Confirm Delete message box will appear.
button.

If you really want to delete the selected macros, select the Yes



How to automatically apply a macro after capture

A macro that has already been recorded can be automatically applied to an image after capture.

Step 1. Select the File/Preferences menu item.
Step 2. The Preferences dialog will appear with the Capture Options page displayed. Select the desired macro from

the Apply Macro After Capture combo box. Select [none] from the top of the combo box to capture images
without applying a macro to it.
Step 3. Press the OK button.



How to automatically apply a macro before printing

A macro that has already been recorded can be selected to be automatically applied to an image before it is printed.

Step 1. Select the File/Print menu item to print an image.

Step 2. The Print dialog will appear. Select the desired macro from the Apply macro before printing combo box.
Select [none] from the top of the combo box to capture images without applying a macro to it.

Step 3. Press the OK button to print the image. The selected macro will be the default macro used the next time an

image is printed.



Save Macro Dialog

The Save Macro dialog specifies the name for the macro that has just been recorded.




Select Macro Dialog

The Select Macro dialog is used to choose a macro to apply to the current image.




Edit Macro Dialog

The Edit Macro dialog displays a list of existing macros to delete or to display the details of.




Macro Details Dialog

The Macro Details dialog displays the list of effects and operations that make up the macro.




Macro Menu
The Macro menu is located on the menu bar and contains the following menu items:

Apply Menu Item
Start Recording Menu Item/Stop Recording Menu Item - Only one of these menu items are available at a given time, depending
on whether a macro is being recorded.

Edit Menu Item



Apply Menu Iltem

Select the Apply menu item to apply a previously recorded macro to the current image.

This menu item is found on the Macro menu.



Start Recording Menu Item

Select the Start Recording menu item to begin recording a macro using the current image.

This menu item is found on the Macro menu. It is available when one or more image window are open and a macro is not being
recorded.



Stop Recording Menu Item
Select the Stop Recording menu item to stop recording a macro.

This menu item is found on the Macro menu. It is available when one or more image window are open and a macro is being
recorded.



Edit Menu Item
Select the Edit menu item to display the Edit Macro dialog.

This menu item is found on the Macro menu. It is always available.



Select the macro to apply to the current image from this list box.



Select one or more macros for deletion or select a single macro to display its effects and/or operations.



Press the Details button after selecting a single macro to display its operations and/or effects.



Select on or more macros from the list and press the Delete button to delete the selected macros.



Enter the name of the new macro in this edit box. The chosen name cannot already be used by an existing macro.



Press the Close button to close the Macro Details dialog.



This list box displays the order of the operations and effects that compose the macro selected in the Macro Edit dialog.



Select the macro to automatically apply to an image after it is captured from this combo box.



Select the macro to automatically apply to an image before it is printed from this combo box.



Select the Include Owned Popup Windows In Capture check box to capture popup windows and menus belonging to the
selected window in addition to the selected window.



Select Macro File Dialog
This dialog is used to change the path to the macro definition file. This dialog is invoked by pressing the Browse button on the
General/Timer page of the Preferences dialog . This option is only available for multiple user licenses.

Although this dialog will allow any file extension to be used, it is highly recommend that the name of the macro definition file be
MACRO.CPM. Future versions of Capture Professional may require this.



The Macro Path edit box contains the path to the macro definition file being used. This option is only visible for multi-user
licenses. Press the Browse... button to change the macro definition file name.



Pressing the Browse button will cause the Select Macro File dialog to appear, allowing the path and/or filename to the macro
definition file to be changed.



Enter the number of images to capture in the 'Use the timer to capture’ edit box. The first image will be captured after the
number of seconds specified in the 'Time before first capture’ edit box. Subsequent images will be captured after the number of
seconds specified in the 'Time between captures' edit box. To capture only one image, set the value in this edit box to 1.



Enter the number of seconds of delay between captures when using the timer to capture multiple images in this edit box. The
value in the 'Use the timer to capture' edit box must be 2 or greater and the Use timer check box must be checked to enable this
edit box. Avalue between 1 second and 3600 seconds (1 hour) can be chosen.



Paste Into Current Image Menu Item

Select the Paste Into Current Image menu item to paste the clipboard image into the current image. The clipboard image will
automatically be converted to the color depth of the current image.

When the image is pasted, it is placed at the upper right corner of the current image. The pasted image can then be
repositioned. If the drawing tool is changed or a menu is pulled down, the image will be pasted into place.

This menu item is located on the Edit menu.

To paste a clipboard image into the current image:

Step 1. Select the Edit/Paste Into Current Imge menu item. The clipboard image will be pasted into the upper-left
corner of the current image.

Step 2. Move the cursor into the selected rectangle. The cursor will change to
Step 3. Press and hold the left mouse button down.
Step 4. Move the pasted image to the desired location.

Step 5. Release the left mouse button.



Select the Control check box to use the control key in conjuction with the selected hotkey to activate the asscociated capture
mode.

For example, if the rectangle mode hotkey is 'R' and the Control and Shift check boxes are checked, the rectangle mode hotkey
is used by pressing and holding the control and shift keys while pressing the 'R' key.



Select the Shift check box to use the shift key in conjuction with the selected hotkey to activate the asscociated capture mode.

For example, if the rectangle mode hotkey is 'R' and the Control and Shift check boxes are checked, the rectangle mode hotkey
is used by pressing and holding the control and shift keys while pressing the 'R’ key.



Select the Alt check box to use the alt key in conjuction with the selected hotkey to activate the asscociated capture mode.

For example, if the active window mode hotkey is 'W' and the Control, Alt and Shift check boxes are checked, the rectangle
mode hotkey is used by pressing and holding the control, alt and shift keys while pressing the "W' key.



Select the hotkey to begin repeat the last image capture from the Repeat Last Capture Hotkey combo box.



Select the hotkey to capture the active client area from the Active Client Area Capture Hotkey combo box.



Select the hotkey to capture the active window from the Active Window Capture Hotkey combo box.



How to Capture Direct X Game Screens

Capture Professional can capture Direct X screens using the Desktop capture mode. In fact, Capture Professional’s multiple
document interface is ideal for capturing game screens, as it allows multiple images to be captured before any image is saved.
However, to maximize its usefulness for capturing game screens, a few settings should be changed.

By default the Desktop capture hotkey is CTRL + SHIFT + ‘D’.  Many games use these keys to perform an action that may be
undesirable for the image you are trying to capture. For this reason, change the Desktop capture hotkey to a key not used by
the game and deselect the Ctrl, Alt and Shift check boxes for the Desktop hotkey. The Destktop hotkey is set on the Hotkey
Setup page of the Preferences dialog.

By default, Capture Professional appears immediately after capture. Disable this be havior by unchecking the Popup after
capture check box on the General/Timer page of the Preferences dialog.

If the Enable direct capture check box on the Direct Capture page of the Preferences dialog is checked, it should be unchecked.



How to Repeat Captures

The same window or area can be captured over and over again by using the Repeat Last Capture feature. This feature repeats
the last capture mode used. For example, if rectangle mode is used to capture a rectangle and then window mode is used to
capture a window, then using the repeat last capture feature will capture the previous window again, if it still exists.

To Repeat the Last Capture:
Step 1. Select the Capture/Repeat Last Capture menu item

-OR- Use the repeat last capture hotkey sequence. The default hotkey sequence for desktop capture is CTRL +
SHIFT + ‘L’. To use this sequence, press and hold the Control key, press and hold the Shift key, press the ‘L'
key and then release all three keys. This hotkey sequence can be changed on the Hotkey Setup page.



Repeat Last Capture Menu Item

Select the Repeat Last Capture menu item to begin repeat the last capture mode used . This menu item is located on the
Capture menu.



Wash Out Effect

The Wash Out effect blends the colors of the current image or its selected area with the background color. The blend is
continuous throughout the area applied.

This effect is only available for 24-bit, true color images.



Fade Edges Effect

The Fade Edges effect gradually blends the edges selected in the Fade Edges dialog with the background color. The fade is
greatest at the edge of the image and least where the fade ends. The distance that the fade extends from the edge towards the

center of the image is also determined in the Fade Edges dialog .

This effect is only available for 24-bit, true color images and can only be applied to the entire image.



Wash Out Menu Item

Select the Wash Out menu item to begin washing out the image . This menu item is located on the Effects menu.



Fade Edges Menu Item

Select the Fade Edges menu item to begin fading the edges of the current image. This menu item is located on the Effects
menu.



Select the Top check box to fade the top edge of the image. Unselect the check box to leave the top edge of the image alone.



Select the Right check box to fade the right edge of the image. Unselect the check box to leave the right edge of the image
alone.



Select the Left check box to fade the left edge of the image. Unselect the check box to leave the left edge of the image alone.



Select the Bottom check box to fade the bottom edge of the image. Unselect the check box to leave the bottom edge of the
image alone.



Enter the distance of the fade from the outer edge to the point that the fade ends. This value is specified in pixels.



Move the Fade Length slider to left to increase the length of the fade. To decrease the length of the fade, move the slider to the
right.



Fade Edges Dialog

The Fade Edges dialog is used to select edges to fade and the distance that the fade extends from the image towards the center
of the image. At least one edge must be selected.



Select the Include parents of popup windows in capture check box to capture all parent windows of a popup window. This
option affects the behavior of window capture and active window capture modes. When used, moving the cursor over a popup
window selects the popup window, its parent and any other popup windows the parent may have. This option is only available
when the Include owned popup windows in capture check box is selected.



Move this slider to the right to increase the amount of the background color that is blended into the current image or its selected
area. Move this slider to the right to increase the visiblility of the current image or its selected area.



Enter a larger value in this edit box or press the up arrow to increase the amount of the background color that is blended into the
current image or its selected area. Enter a smaller value or press the down arrow to increase the visiblility of the current image
or its selected area.



Select the "Capture entire client area, automatically scrolling if necessary" check box to automatically scroll the client area of an
image when using active client area and client area modes. The client area must have an integrated veritcal scroll bar on the
side of the window.

Some windows have scroll bar controls instead of integrated scroll bars. Capture Professional is not compatible with these
windows.



Select this check box to display long tool tips for the tool palette on the left side of the Capture Professional main window. The
long tool tips contain brief descriptions on how to use each tool. When this check box is cleared, only the tool tip's title is used.






